Veritas NetBackup™ OpenStorage Solutions Guide for Disk

UNIX, Windows, Linux

Release 8.1
Veritas NetBackup™ OpenStorage Solutions Guide for Disk

Last updated: 2017-09-25

Legal Notice

Copyright © 2017 Veritas Technologies LLC. All rights reserved.

Veritas, the Veritas Logo, and NetBackup are trademarks or registered trademarks of Veritas Technologies LLC or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This product may contain third party software for which Veritas is required to provide attribution to the third party ("Third Party Programs"). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Refer to the third party legal notices document accompanying this Veritas product or available at:

https://www.veritas.com/about/legal/license-agreements

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Veritas Technologies LLC and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. VERITAS TECHNOLOGIES LLC SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 "Commercial Computer Software - Restricted Rights" and DFARS 227.7202, et seq. "Commercial Computer Software and Commercial Computer Software Documentation," as applicable, and any successor regulations, whether delivered by Veritas as on premises or hosted services. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.

Veritas Technologies LLC
500 E Middlefield Road
Mountain View, CA 94043
Technical Support

Technical Support maintains support centers globally. All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policies. For information about our support offerings and how to contact Technical Support, visit our website:

https://www.veritas.com/support

You can manage your Veritas account information at the following URL:

https://my.veritas.com

If you have questions regarding an existing support agreement, please email the support agreement administration team for your region as follows:

Worldwide (except Japan)  CustomerCare@veritas.com
Japan  CustomerCare_Japan@veritas.com

Documentation

The latest documentation is available on the Veritas website:

https://sort.veritas.com/documents

Documentation feedback

Your feedback is important to us. Suggest improvements or report errors or omissions to the documentation. Include the document title, document version, chapter title, and section title of the text on which you are reporting. Send feedback to:

NB.docs@veritas.com

You can also see documentation information or ask a question on the Veritas community site:

http://www.veritas.com/community/

Veritas Services and Operations Readiness Tools (SORT)

Veritas Services and Operations Readiness Tools (SORT) is a website that provides information and tools to automate and simplify certain time-consuming administrative tasks. Depending on the product, SORT helps you prepare for installations and upgrades, identify risks in your datacenters, and improve operational efficiency. To see what services and tools SORT provides for your product, see the data sheet:

Chapter 5 Configuring OpenStorage in NetBackup

- Configuring OpenStorage disk appliance storage ......................................................... 30
- Configuring an OpenStorage storage server for backups ........................................... 31
- Configuring an OpenStorage disk pool for backups ................................................... 44
  - OpenStorage disk pool properties ........................................................................ 51
- Configuring an OpenStorage storage unit ................................................................. 53
  - OpenStorage storage unit properties ................................................................... 55
    - About OpenStorage storage unit recommendations ........................................... 57
- Configuring OpenStorage optimized synthetic backups .............................................. 59
- Configuring OpenStorage direct to tape ................................................................. 60
- Configuring optimized duplication to an OpenStorage device within the same NetBackup domain ................................................................. 61
  - About OpenStorage optimized duplication within the same domain ................... 63
- Configuring NetBackup optimized duplication or replication behavior ...................... 65
- Configuring replication to an OpenStorage device in a different domain .................. 68
  - About NetBackup Auto Image Replication ....................................................... 69
- About storage lifecycle policies ............................................................................... 79
- About the storage lifecycle policies required for Auto Image Replication.................. 80
- Creating a storage lifecycle policy .......................................................................... 82
  - Storage Lifecycle Policy dialog box settings ...................................................... 85
- Creating a backup policy ......................................................................................... 87
- Adding OpenStorage functionality to an existing environment .................................. 89

Chapter 6 Managing OpenStorage

- Managing OpenStorage storage servers ................................................................. 90
  - Viewing OpenStorage storage servers ............................................................... 91
  - Determining OpenStorage storage server state ................................................... 91
  - Changing OpenStorage storage server properties .............................................. 91
  - Setting OpenStorage storage server attributes ............................................... 92
  - Removing OpenStorage storage server attributes .......................................... 93
  - Updating an OpenStorage storage server to reflect plug-in updates .................. 93
- Deleting an OpenStorage storage server ............................................................... 95
- Managing OpenStorage server credentials ........................................................... 95
  - Determining if OpenStorage server credentials exist ....................................... 96
  - Adding OpenStorage server credentials ........................................................... 96
  - Changing OpenStorage server credentials ......................................................... 96
Introducing disk appliance storage solutions

This chapter includes the following topics:

■ About storage solutions for backups to disk
■ About the NetBackup OpenStorage option
■ About control of the storage
■ About replication to OpenStorage devices

About storage solutions for backups to disk

This guide describes how to configure and use an intelligent disk appliance in NetBackup for backups. The disk appliance must conform to the Veritas OpenStorage API.

See “About the NetBackup OpenStorage option” on page 7.

Information about how to configure and use NetBackup with snapshots on disk appliance storage is available in a different guide.

See the NetBackup Replication Director Solutions Guide:
http://www.veritas.com/docs/DOC5332

About the NetBackup OpenStorage option

OpenStorage is a Veritas API that allows NetBackup to communicate with the storage implementations that conform to the API. Storage vendors participate in the Veritas Technology Partners Program. Veritas qualifies their storage solutions for the OpenStorage API.
Depending on the storage implementation, OpenStorage may provide the following capabilities:

- Share disks. Multiple heterogeneous media servers can access the same disk volume concurrently.
- Balance load and performance. NetBackup balances backup jobs and storage usage among the media servers and disk pools. For each backup job, NetBackup chooses the least full disk volume and least busy media server.
- Use of disk appliance capabilities, which may include optimized off-host duplication and deduplicated storage capabilities.
- Fast storage provisioning.
- Almost unlimited storage.
- Alternative to off-site vaulting.
- Simplified disaster recovery. Access your data from anywhere over the Internet.

Figure 1-1 shows an OpenStorage configuration that uses a disk appliance.

![Figure 1-1](image)

**OpenStorage appliance configuration**

Load-balanced NetBackup media servers are data movers. They have the vendor plug-in installed.

Any connectivity (directly attached, SAN, LAN)

The disk appliance is the storage server.

---

### About control of the storage

The vendor’s storage implementation controls the storage format and where the images reside on the storage. The vendor controls the data transfer method. Consequently, performance and storage utilization are highly optimized.

NetBackup has no knowledge of how the backup images are stored. Also, Veritas does not control which capabilities the vendor exposes through the OpenStorage API. Similarly, Veritas and NetBackup have no control over the communication between the vendor plug-in and the storage server. The vendor determines the API or protocol to use between the plug-in and the storage server.
NetBackup determines when backup images are created, copied, or deleted. Images cannot be moved, expired, or deleted on the storage unless NetBackup instructs the appliance to do so through the API.

**About replication to OpenStorage devices**

NetBackup offers two types of replication to OpenStorage devices, as follows:

- **Backups**
  - Replication of backups to another NetBackup domain is known as Auto Image Replication.
  - Use this guide to configure Auto Image Replication of backups to an OpenStorage device.
  - NetBackup deduplication also supports Auto Image Replication.
  - See the NetBackup Deduplication Guide:
    - http://www.veritas.com/docs/DOC5332

- **Snapshots**
  - Snapshot replication within the same domain.
  - Use this type to replicate snapshots from one OpenStorage device to the same device or to another device of the same vendor and type.
  - See the NetBackup Replication Director Solutions Guide:
    - http://www.veritas.com/docs/DOC5332
Planning your deployment

This chapter includes the following topics:

- Planning your OpenStorage deployment
- About OpenStorage requirements and limitations
- About OpenStorage storage servers for backups
- About OpenStorage server credentials
- About OpenStorage data movers for backups
- About the OpenStorage plug-in
- About OpenStorage disk pools for backups
- About OpenStorage optimized duplication and replication
- About OpenStorage optimized synthetic backups
- About storage unit groups for OpenStorage
- About OpenStorage direct to tape

Planning your OpenStorage deployment

Table 2-1 provides an overview of NetBackup OpenStorage. This overview and the topics to which it refers may help you plan your deployment.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Read about requirements and limitations</td>
<td>See “About OpenStorage requirements and limitations” on page 11.</td>
</tr>
</tbody>
</table>

Table 2-1 OpenStorage deployment
### Table 2-1: OpenStorage deployment (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Learn about storage servers, data movers, and credentials</td>
<td>See “About OpenStorage storage servers for backups” on page 12.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About OpenStorage data movers for backups” on page 13.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About OpenStorage server credentials” on page 13.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Learn about disk pools</td>
<td>See “About OpenStorage disk pools for backups” on page 14.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About spanning volumes in OpenStorage disk pools” on page 16.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Learn about optimized duplication and replication</td>
<td>See “About OpenStorage optimized duplication and replication” on page 16.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Learn about optimized synthetic backups</td>
<td>See “About OpenStorage optimized synthetic backups” on page 16.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Learn about storage unit groups for OpenStorage</td>
<td>See “About storage unit groups for OpenStorage” on page 18.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Learn about copy to tape</td>
<td>See “About OpenStorage direct to tape” on page 18.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Learn about provisioning the storage</td>
<td>See “About provisioning the disk appliance storage” on page 24.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Learn about how storage units can control traffic</td>
<td>See “About OpenStorage storage unit recommendations” on page 57.</td>
</tr>
<tr>
<td>Step 10</td>
<td>See the configuration overview topics</td>
<td>See “Configuring OpenStorage disk appliance storage” on page 30.</td>
</tr>
</tbody>
</table>

### About OpenStorage requirements and limitations

The following are the requirements to use the OpenStorage option:

- A NetBackup OpenStorage option license.
- Storage that is exposed to NetBackup through a software plug-in that conforms to the Veritas OpenStorage API.

OpenStorage does not support the following:

- Optimized duplication when a storage unit group is a target of the duplication.
- Optimized duplication with Auto Image Replication.
- Clustering of the media servers that function as data movers. Multiple data movers inherently provide failover capability. Therefore, clustering for failover is not required.
Information about supported systems is available. See the NetBackup compatibility lists at the following URL:

http://www.netbackup.com/compatibility

About OpenStorage storage servers for backups

A storage server is an entity that writes data to and reads data from the storage. It may correspond to a physical appliance or disk array. It may be a higher level construct such as a host-based management software suite for multiple devices. The storage server owns exclusive access to the storage.

For the OpenStorage solutions that use a disk appliance for backups, the disk appliance host is the storage server.

How many storage servers you configure depends on your backup storage requirements. Each disk appliance has one storage server. If you use optimized duplication or replication, additional storage servers are required, as follows:

- **Optimized duplication within the same NetBackup domain**: Optimized duplication in the same domain requires the following storage servers:
  - One for the backup storage, which is the source for the duplication operations.
  - Another to store the copies of the backup images. This storage server hosts the storage that is the target for the duplication operations.
  
  See “About OpenStorage optimized duplication within the same domain” on page 63.

- **Auto Image Replication to a different NetBackup domain**: Auto Image Replication requires the following storage servers:
  - One for the backups in the originating domain. This storage server writes the NetBackup client backups to the storage. It is the source for the duplication operations.
  - Another in the remote domain for the copies of the backup images. This storage server is the target for the duplication operations that run in the originating domain.
  
  See “About NetBackup Auto Image Replication” on page 69.

See “About OpenStorage data movers for backups” on page 13.
About OpenStorage server credentials

When you configure a storage server in the Storage Server Configuration Wizard, you configure its credentials.

NetBackup does the following:

- Saves the credentials so the media servers can log into the storage server. If the storage server is also an NDMP FSE host for direct to tape operations, they both must have the same logon credentials. See "About OpenStorage direct to tape" on page 18.
- Configures each media server you select as a data mover. NetBackup does not monitor connectivity between data movers and the storage server. However, when you configure the credentials, NetBackup configures and maintains an access path between the media server and the storage server. See “About OpenStorage data movers for backups” on page 13.

If the storage server does not require logon credentials, you must enter dummy credentials so that NetBackup configures the media servers as data movers.

About OpenStorage data movers for backups

A data mover is a NetBackup media server that backs up a client and then transfers the data to a storage server. The storage server then writes the data to storage. A data mover also can move data back to primary storage (the client) during restores and from secondary storage to tertiary storage during duplication.

The data movers host a software plug-in they use to communicate with the storage implementation.

When you configure the storage server, you also select the media servers that host the OpenStorage plug-in. Those media server data movers are assigned the credentials for the storage server. The credentials allow the data movers to communicate with the storage server. NetBackup then configures the media servers as data movers.

You can control which data movers are used for backups and duplications when you configure NetBackup storage units.

See “About OpenStorage storage servers for backups” on page 12.

About the OpenStorage plug-in

A software plug-in must reside on every NetBackup media server that moves backup data to the storage server. The plug-in must conform to the Veritas OpenStorage
API specification. The vendor exposes the storage capabilities to NetBackup through the plug-in.

To determine a disk appliance’s capabilities, NetBackup uses the plug-in to query the storage appliance. Capabilities can include deduplicated storage, optimized off-host duplication, and so on.

If a vendor updates their plug-in, you must update NetBackup with the new or changed capabilities exposed by the plug-in.

See “Updating an OpenStorage storage server to reflect plug-in updates” on page 93.

For disk appliance storage, the appliance vendor provides the plug-in. The vendor should provide information about how to install the plug-in.

About OpenStorage disk pools for backups

An OpenStorage disk pool represents the disk storage that is exposed to NetBackup through the OpenStorage API. A disk pool is the storage destination of a NetBackup storage unit.

For disk appliance storage for backups, the vendor may expose the storage as one or more units of storage (that is, disk volumes). The vendor also may expose the volume properties that are related to replication.

A disk pool can represent one or more volumes. If a disk pool represents more than one volume, NetBackup selects a volume for a backup based on the available capacity and the predicted size of the backup. NetBackup tries to write backup data to a single volume. If necessary, backup images span volumes in a disk pool unless the storage implementation does not support volume spanning. Backup images do not span across multiple disk pools.

See “About spanning volumes in OpenStorage disk pools” on page 16.

How many disk pools you configure depends on your storage requirements. It also depends on whether or not you use optimized duplication or replication, as follows:
Optimized duplication within the same NetBackup domain

Optimized duplication in the same domain requires the following disk pools:

- At least one for the backup storage, which is the source for the duplication operations. The source disk pool is on one appliance.
- Another to store the copies of the backup images, which is the target for the duplication operations. The target disk pool is on a different appliance.

See “About OpenStorage optimized duplication within the same domain” on page 63.

Auto Image Replication to a different NetBackup domain

Auto Image Replication disk pools can be either replication source or replication target. The replication properties denote the purpose of the disk pool: source or target. Your storage administrator configures the replication topology of the volumes in the storage devices, and you create the disk pools to match that topology. The disk pools inherit the replication properties from the volumes that you add to them.

See “About the replication topology for Auto Image Replication” on page 75.

Auto Image Replication requires the following disk pools:

- At least one replication source disk pool in the originating domain. A replication source disk pool is one to which you send your backups. The backup images on the source disk pool are replicated to a disk pool in the remote domain.
- At least one replication target disk pool in the remote domain. A replication target disk pool is the target for the duplication operations that run in the originating domain.

Figure 2-1 shows a disk pool configuration in a disk appliance.

Figure 2-1  OpenStorage disk appliance disk pools

Disk appliance  DP_Gold_OpenStorage

See “Configuring an OpenStorage disk pool for backups” on page 44.
About spanning volumes in OpenStorage disk pools

One of the capabilities a vendor may expose is the potential for images to span across volumes within a disk pool. NetBackup uses that capability to use the disk storage most effectively. NetBackup breaks up backup images into fragments and stores a fragment or fragments if a full image does not fit into the space available.

In NetBackup, the **SpanImages** attribute specifies that backup images can span across volumes in a disk pool. The **SpanImages** attribute applies to both storage servers and disk pools.

Volume spanning is not a trait that the OpenStorage vendor plug-in exposes. Therefore, by default NetBackup does not include the **SpanImages** attribute on storage servers and disk pools. You must set the **SpanImages** attribute on the storage server and the disk pools so that backup images span volumes.

See “Setting OpenStorage storage server attributes” on page 92.

See “Setting OpenStorage disk pool attributes” on page 106.

NetBackup does not support disk volume spanning for replication. NetBackup fails backup jobs to the disk pools that span volumes if the backup job is in a storage lifecycle policy that also contains a replication operation.

About OpenStorage optimized duplication and replication

If an OpenStorage disk appliance can copy the data on one appliance to another appliance of the same type, NetBackup can use that capability. The following table lists the duplication methods in NetBackup that can use the functionality:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplication within the same NetBackup domain</td>
<td>See “About OpenStorage optimized duplication within the same domain” on page 63.</td>
</tr>
<tr>
<td>Replication to a remote NetBackup domain</td>
<td>See “About NetBackup Auto Image Replication” on page 69.</td>
</tr>
</tbody>
</table>

About OpenStorage optimized synthetic backups

One of the capabilities a vendor may expose is the disk appliance’s potential to construct synthetic backup images. A media server uses messages to instruct the
storage server which full and incremental backup images to use to create the synthetic backup. The storage server constructs (or synthesizes) the backup image directly on the disk storage. The backups that NetBackup creates in this way are known as optimized synthetic backups.

The OpenStorage optimized synthetic backup method provides the following benefits:

- Faster than a synthetic backup.
  - Regular synthetic backups are constructed on the media server. They are moved across the network from the storage server to the media server and synthesized into one image. The synthetic image is then moved back to the storage server.
- Requires no data movement across the network.
  - Regular synthetic backups use network traffic.
- Uses fewer disk resources, depending on the vendor implementation.
  - The storage vendor determines the storage implementation. If the disk appliance uses data deduplication, duplicate data is not created and stored.

In NetBackup, the `OptimizedImage` attribute enables optimized synthetic backup. It applies to both storage servers and disk pools.

If the original vendor plug-in exposed optimized synthetic backup functionality, the storage server and disk pools inherited that functionality. However, if your OpenStorage vendor updates their plug-in to add optimized synthetic backup functionality, you have to update NetBackup.

See "Adding OpenStorage functionality to an existing environment" on page 89.

The following table describes the requirements and limitations for OpenStorage optimized synthetic backups.

<table>
<thead>
<tr>
<th>Table 2-3</th>
<th>OpenStorage optimized synthetic backups requirements and limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Requirements</td>
<td>The following are the requirements for optimized synthetic backups:</td>
</tr>
<tr>
<td></td>
<td>- Optimized synthetic backups are licensed on the NetBackup master server.</td>
</tr>
<tr>
<td></td>
<td>- The plug-in from the disk appliance vendor supports the OpenStorage <code>OptimizedImage</code> attribute.</td>
</tr>
<tr>
<td></td>
<td>- The vendor plug-in is installed on each media server that connects to the storage appliance.</td>
</tr>
<tr>
<td></td>
<td>- The target storage unit's disk pool is the same disk pool on which the source images reside.</td>
</tr>
<tr>
<td>Limitations</td>
<td>NetBackup does not support storage unit groups as a destination for optimized synthetic backups.</td>
</tr>
</tbody>
</table>
About storage unit groups for OpenStorage

You can use a storage unit group as a backup destination for OpenStorage storage. A storage unit group must contain only the storage units that have the same type of OpenStorage appliance as the storage destination.

Storage unit groups avoid a single point of failure that can interrupt backup service.

The best storage savings occur when a backup policy stores its data in the same deduplication destination disk pool instead of across multiple disk pools. For this reason, the Failover method for the Storage unit selection uses the least amount of storage. All of the other methods are designed to use different storage every time the backup runs. Veritas recommends that you select the Failover method for the Storage unit selection type.

Table 2-4 Requirements and limitations for storage unit groups

<table>
<thead>
<tr>
<th>What</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirements</td>
<td>A group must contain storage units of one storage destination type only.</td>
</tr>
<tr>
<td>Limitations</td>
<td>NetBackup does not support the following for storage unit groups:</td>
</tr>
<tr>
<td></td>
<td>■ Optimized duplication of deduplicated data. If you use a storage unit</td>
</tr>
<tr>
<td></td>
<td>group as a destination for optimized duplication of deduplicated data,</td>
</tr>
<tr>
<td></td>
<td>NetBackup uses regular duplication.</td>
</tr>
<tr>
<td></td>
<td>See “About OpenStorage optimized duplication within the same domain” on</td>
</tr>
<tr>
<td></td>
<td>page 63.</td>
</tr>
<tr>
<td></td>
<td>■ Optimized synthetic backups. If NetBackup cannot produce the optimized</td>
</tr>
<tr>
<td></td>
<td>synthetic backup, NetBackup creates the more data-movement intensive</td>
</tr>
<tr>
<td></td>
<td>synthetic backup.</td>
</tr>
<tr>
<td></td>
<td>See “About OpenStorage optimized synthetic backups” on page 16.</td>
</tr>
</tbody>
</table>

About OpenStorage direct to tape

OpenStorage direct to tape lets you copy NetBackup backup images directly from a disk appliance to tape. The copy operation does not use NetBackup media server I/O.

NetBackup manages the copied images based on retention periods you define.

Direct to tape uses the Network Data Management Protocol (NDMP) for the copy operations. Direct to tape requires specific NDMP features and release levels.

See “About NDMP requirements for OpenStorage direct to tape” on page 19.

NetBackup media servers manage the operations. The media servers require the NetBackup for NDMP software and specific NetBackup release levels.
See “About media server recommendations for OpenStorage direct to tape” on page 22.

How to configure OpenStorage direct to tape is described elsewhere.

See “Configuring OpenStorage direct to tape” on page 60.

### About NDMP requirements for OpenStorage direct to tape

If the NDMP requirements are not met, the images are still duplicated. However, the copy operation uses the traditional duplication method of reading the image through the NetBackup media server and writing out to tape.

<table>
<thead>
<tr>
<th>NDMP functionality</th>
<th>Description</th>
</tr>
</thead>
</table>
| **NDMP File Service Extension** | The OpenStorage disk appliance requires an NDMP server that supports the OpenStorage direct to tape specification. The Veritas OpenStorage Partner Program publishes the specification. The direct to tape feature uses a subset of the NDMP File Service Extension (FSE) commands. The host that provides the NDMP FSE functionality can be one of the following entities:  
  - The disk appliance storage server.  
    See “About OpenStorage storage servers for backups” on page 12.  
  - An alternative name (that is, interface) for the storage server.  
  - A separate host that interacts with the disk appliance. The host must be directly connected to the disk appliance. |
| **NDMP tape server**      | Direct to tape requires an NDMP tape server for the destination tape library. The NDMP tape server must support NDMP v4 or later. The host that provides the NDMP tape server functionality can be one of the following entities:  
  - The same host that provides the NDMP FSE functionality.  
    If one host provides the NDMP FSE and NDMP tape server functionality, the tape library must be attached directly to that host. Data does not travel over the network.  
    See Figure 2-2 on page 20.  
  - A host that is embedded in the tape library. Data travels over the network.  
    See Figure 2-3 on page 20.  
  - A separate host to which the tape server is directly attached. Data travels over the network.  
    See Figure 2-4 on page 21. |
Table 2-5  
NDMP requirements for OpenStorage direct to tape (continued)

<table>
<thead>
<tr>
<th>NDMP functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credentials</td>
<td>The NDMP FSE server must use the same credentials as the OpenStorage storage server. <strong>Note:</strong> If the NDMP FSE host is the same host as the storage server, you must configure a DNS alias for the host. Then, use the alias name when you configure the NDMP credentials in NetBackup. The credentials must be the same as the credentials that you used for the storage server. NetBackup does not allow multiple credentials for the same host name. If you use the NDMP FSE server for other purposes, do not configure the credentials differently for that purpose. For example, if you also use the NDMP FSE server as a VTL with NetBackup, use the same credentials when you configure it with NetBackup.</td>
</tr>
</tbody>
</table>

Figure 2-2  
OpenStorage server provides all NDMP functionality

Figure 2-3  
Tape library with embedded NDMP tape server host
About media server requirements for OpenStorage direct to tape

Although NetBackup media servers do not provide I/O, they are used to manage the operations.

Table 2-6 Media server requirements for OpenStorage direct to tape

<table>
<thead>
<tr>
<th>Media server function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read side media server</td>
<td>In this context, the read side media server does not read or move the backup images. It manages the read side of the NDMP copy operation. The read side media server requires the following:</td>
</tr>
<tr>
<td></td>
<td>■ The NetBackup for NDMP software.</td>
</tr>
<tr>
<td></td>
<td>■ Logon credentials for the disk appliance storage server and the NDMP FSE host. If the NDMP FSE host and the storage server host have the same name, NetBackup uses the storage server credentials to logon to the NDMP host. Therefore, you do not have to configure NDMP credentials in NetBackup. This NetBackup behavior means that the credentials you create for the disk appliance storage server and the NDMP FSE host must be the same.</td>
</tr>
<tr>
<td></td>
<td>If the NDMP FSE hostname is different than the storage server hostname, you must configure logon credentials in NetBackup for that NDMP host.</td>
</tr>
<tr>
<td>Write side media server</td>
<td>In this context, the write side media server does not move or write the backup images. It manages the write side of the NDMP copy operation. The write side media server requires the following:</td>
</tr>
<tr>
<td></td>
<td>■ The NetBackup for NDMP software.</td>
</tr>
<tr>
<td></td>
<td>■ Logon credentials for the NDMP tape server host.</td>
</tr>
</tbody>
</table>

If one host provides both NDMP FSE and NDMP tape server functionality, one media server functions as both the read and write server.
About media server recommendations for OpenStorage direct to tape

To simplify OpenStorage configuration and management, Veritas recommends that you use one set of media servers for all OpenStorage activity. The media servers then can function as either read or write side servers for direct to tape operations. They also can function as data movers for other OpenStorage operations.

For each media server in the set, do the following:

- Configure logon credentials to the OpenStorage storage server.
- Install the NetBackup for NDMP software.
- Configure logon credentials for the NDMP FSE host (if required).
- Configure logon credentials for the NDMP tape server host.

See “About OpenStorage data movers for backups” on page 13.

About OpenStorage direct to tape limitations

The following limitations exist:

- The destination storage unit must be NDMP. You cannot use a storage unit group.
- You cannot make multiple copies with one copy operation.
- Backup images are not multiplexed when written to tape.

About the OpenStorage direct to tape process

The following is an overview of the direct copy to tape process:

- NetBackup verifies that the image to be duplicated resides on an OpenStorage device.
- NetBackup verifies that the disk appliance NDMP host supports the OpenStorage direct to tape specification.
- NetBackup selects the write side media server, a destination tape drive, and a tape volume.
  NetBackup selects a media server that has credentials to the NDMP tape server host. The media servers NetBackup considers are listed in the destination storage unit.
  The write side media server does the following:
  - Establishes an NDMP session with the NDMP tape server and confirms that it supports the NDMP v4 protocol.
Mounts, opens, and positions the tape and then uses NDMP to write a header to the tape.

Sets up the NDMP mover interface on the NDMP tape server. It also monitors the progress of the write operation by waiting for any NDMP notifications.

NetBackup selects the read side media server. If the write side media server has credentials for the NDMP FSE host, NetBackup selects it as the read side server. If it does not have credentials, NetBackup selects a media server with credentials to the NDMP FSE host.

The read side media server does the following:

Establishes an NDMP session with the NDMP FSE host.

Opens the files to be copied.

Sets up the NDMP mover interface on the NDMP FSE host. It also monitors the progress of the read operation by waiting for any NDMP notifications.

By means of the NDMP protocol, the backup images on the disk appliance are copied to the tape storage.

After the images are copied, the read and write media servers close their connections to their respective NDMP hosts.

NetBackup validates the image copies; if valid, NetBackup ends the duplication job with status 0 (success).
Provisioning the storage

This chapter includes the following topics:

- About provisioning the disk appliance storage
- Installing the disk appliance plug-in

About provisioning the disk appliance storage

You or your storage administrator must install and configure the disk storage appliance or appliances in your environment. The appliances must be operational before you can use them for backups or duplication.

Specifically, do the following:

- Install the appliances in your environment.
- Install the vendor software packages on all NetBackup media servers that connect to the appliances.
  See “Installing the disk appliance plug-in” on page 25.
- Perform vendor-specific steps to configure the appliances. Use the vendor's processes and procedures to configure the appliance so that it works with your environment. To configure the storage, you may be required to do the following:
  - Assign the appliance a name. NetBackup uses the name to identify the appliance.
  - Divide the appliance into one or more logical units of space. NetBackup refers to these logical units as disk volumes. NetBackup aggregates the disk volumes into disk pools.
  - Configure the replication properties of the appliance volumes.

How many appliances you provision depends on your storage requirements. It also depends on whether or not you use optimized duplication or replication, as follows:
You must provision at least two appliances:

- One appliance for the backups, which is the source for the duplication operations.
- Another appliance for the copies of the backup images, which is the target for the duplication operations.

See “About OpenStorage optimized duplication within the same domain” on page 63.

Auto Image Replication to a different NetBackup domain

You must provision at least two appliances:

- One appliance for the backups in the originating domain. This is the appliance on which NetBackup stores your client backups. It is the source for the duplication operations.
- Another appliance in the remote domain for the copies of the backup images. This appliance is the target for the duplication operations that run in the originating domain.

See “About NetBackup Auto Image Replication” on page 69.

Instructions for how to install and configure the appliance are beyond the scope of the NetBackup documentation. For instructions, refer to the vendor documentation.

Installing the disk appliance plug-in

If your storage is a disk appliance, the storage vendor’s release package includes a plug-in to communicate with NetBackup. The plug-in installs on the NetBackup media servers that connect to the storage server.

Table 3-1 To install the disk appliance plug-in

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Install the plug-in on all NetBackup media servers that connect to the appliance.</td>
<td>See the vendor’s installation instructions. The vendor’s plug-in installation process may also configure the storage server. See “Configuring an OpenStorage storage server for backups” on page 31.</td>
</tr>
<tr>
<td>2</td>
<td>Restart the NetBackup Remote Manager and Monitor Service on each media server on which you install the plug-in.</td>
<td>See the NetBackup Administrator's Guide, Volume I.</td>
</tr>
</tbody>
</table>

After the installation of the plug-in, newly created storage servers and disk pools inherit all of the functionality that the vendor exposes in their plug-in. However, if
the vendor updates the plug-in to add new functionality, you must update existing storage servers and disk pools to use that new functionality.

See “Updating an OpenStorage storage server to reflect plug-in updates” on page 93.

Vendor plug-ins must be 64-bit except for Windows Server 2008 R2, which may be 32-bit.

See “Adding OpenStorage functionality to an existing environment” on page 89.
This chapter includes the following topics:

- About the OpenStorage license
- Licensing OpenStorage

About the OpenStorage license

OpenStorage is a feature that is licensed separately from base NetBackup. The license that activates OpenStorage also activates the NetBackup for NDMP software, which is used for the direct to tape feature. You must install the NetBackup for NDMP software on the media servers that you use for direct to tape. You also must enter the license on those media servers.

Enter the license on the master server and on each media server that connects to the disk appliance.

See “Licensing OpenStorage” on page 28.

The license only enables the NetBackup functionality. You must purchase a storage vendor’s product and install the storage vendor’s NetBackup plug-in.

If you remove the license or if it expires, the following restrictions apply:

- You cannot create the disk pools or the storage units that use the disk pools.
- NetBackup jobs fail that attempt to use the disk pools or the storage units that are based on the disk pools. The error message indicates that the feature is not licensed.

NetBackup does not delete the disk pools or the storage units that are based on the disk pools. You can use them again if you enter a valid license.
Licensing OpenStorage

No special installation is required for the NetBackup components of OpenStorage. However, you must enter a license.

The following procedure describes how to use the **NetBackup Administration Console** to enter the license.

---

**Note:** Enter the license on the NetBackup master server and on each media server that connects to the disk appliance. If you use the direct to tape feature, also enter the license on each NetBackup media server that you use for direct to tape. Those media servers also must have the NetBackup for NDMP software installed.

---

See “About OpenStorage direct to tape” on page 18.

**To license OpenStorage**

1. On the **Help** menu of the **NetBackup Administration Console** on the NetBackup master server, select **License Keys**.
2. In the **NetBackup License Keys** dialog box, click **New**.
3. In the **Add a New License Key** dialog box, enter the license key and click **Add** or **OK**.
4. In the **NetBackup License Key** dialog box, click **Close**.
5. Restart all the NetBackup services and daemons.
Configuring OpenStorage in NetBackup

This chapter includes the following topics:

- Configuring OpenStorage disk appliance storage
- Configuring an OpenStorage storage server for backups
- Configuring an OpenStorage disk pool for backups
- Configuring an OpenStorage storage unit
- Configuring OpenStorage optimized synthetic backups
- Configuring OpenStorage direct to tape
- Configuring optimized duplication to an OpenStorage device within the same NetBackup domain
- Configuring replication to an OpenStorage device in a different domain
- About storage lifecycle policies
- About the storage lifecycle policies required for Auto Image Replication
- Creating a storage lifecycle policy
- Creating a backup policy
- Adding OpenStorage functionality to an existing environment
Configuring OpenStorage disk appliance storage

Table 5-1 describes the tasks to configure NetBackup to use a third-party vendor's disk appliance that conforms to the Veritas OpenStorage API.

The NetBackup Administrator's Guide, Volume I describe how to configure a base NetBackup environment. See the NetBackup Administrator's Guide, Volume I:

http://www.veritas.com/docs/DOC5332

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Learn about planning your deployment</td>
<td>See “Planning your OpenStorage deployment” on page 10.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Enable legacy logging</td>
<td>See “Creating NetBackup log file directories for OpenStorage” on page 120.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Provision the storage and install the plug-in</td>
<td>How many devices you provision depends on your storage requirements. It also depends on whether or not you use optimized duplication or replication. See “About NetBackup Auto Image Replication” on page 69. See “About provisioning the disk appliance storage” on page 24. See “Installing the disk appliance plug-in” on page 25.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure one or more storage servers</td>
<td>How many storage servers you configure depends on your storage requirements. It also depends on whether or not you use optimized duplication or replication. See “About OpenStorage storage servers for backups” on page 12. See “Configuring an OpenStorage storage server for backups” on page 31.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Configure disk pools</td>
<td>How many disk pools you configure depends on your storage requirements. It also depends on whether or not you use optimized duplication or replication. See “About the replication topology for Auto Image Replication” on page 75. See “Viewing the replication topology for Auto Image Replication” on page 76. See “Configuring an OpenStorage disk pool for backups” on page 44.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Configure storage units</td>
<td>See “Configuring an OpenStorage storage unit” on page 53.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Configure optimized duplication</td>
<td>Optimized duplication is optional. See “Configuring optimized duplication to an OpenStorage device within the same NetBackup domain” on page 61.</td>
</tr>
</tbody>
</table>
**Table 5-1** OpenStorage disk appliance configuration tasks *(continued)*

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 8</td>
<td>Configure replication</td>
<td>Replication is optional. See “Configuring replication to an OpenStorage device in a different domain” on page 68.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Configure copy to tape</td>
<td>Copy to tape is optional. See “About OpenStorage direct to tape” on page 18. See “Configuring OpenStorage direct to tape” on page 60.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Configure optimized synthetic backups</td>
<td>Optimized synthetic backups are optional. See “Configuring OpenStorage optimized synthetic backups” on page 59.</td>
</tr>
<tr>
<td>Step 11</td>
<td>Create a backup policy</td>
<td>To duplicate or replicate images, a backup policy in the source domain must indicate the configured SLP as the <strong>Policy storage</strong> selection. See “Creating a backup policy” on page 87.</td>
</tr>
</tbody>
</table>

**Configuring an OpenStorage storage server for backups**

Configure in this context means to add the storage host to NetBackup as a storage server. When you configure a storage server, you also configure the media servers that function as data movers.

If the storage host does not require logon credentials, you must enter dummy credentials so that NetBackup configures the media servers as data movers.

**To configure an OpenStorage storage server by using the wizard**

1. In the NetBackup Administration Console, select either NetBackup Management or Media and Device Management.

2. In the right pane, click Configure Disk Storage Servers.
3 On the **Welcome** panel, the types of storage servers that you can configure depend on the options for which you are licensed.

The following is an example of the **Welcome** panel:

![Storage Server Configuration Wizard](image)

Select **OpenStorage** and then click **Next**. The **Add Storage Server** panel appears next.
4 The **Add Storage Server** panel is where you enter the information about the storage server panel.

The following is an example of the **Add Storage Server** wizard panel:

![Add Storage Server Wizard](image)

Enter the appropriate information or select the appropriate options, as follows:

**Media server**

Select the media server to use to query the storage server. The storage plug-in must be installed on the media server.

By default, the first media server is selected.

**Storage server name**

Enter the host name of the storage server. For backups to disk appliance storage, the storage server is the disk appliance host.

You can run a NetBackup command to determine the storage server name that the **OpenStorage** plug-in exposes.

See “Viewing the replication topology for Auto Image Replication” on page 76.
Enter the storage server type. For disk appliance storage for backups, your storage vendor provides the string that identifies the storage type.

The Storage server type is case-sensitive.

Username
Enter the user name with which to log on to the storage host. For backups to disk appliance storage, the storage server is the disk appliance host.

If the storage host does not require logon credentials, you must enter dummy credentials so that NetBackup configures the media server as a data mover.

Password
Enter the password for the logon account to the storage server.

Confirm password
To confirm the password, re-enter the password.

The Additional Media Server Configuration panel appears.
5 On the **Additional Media Server Configuration** panel, select additional media servers for your OpenStorage environment. The media servers function as backup hosts and data movers. NetBackup uses them to load balance backup and replication jobs. NetBackup chooses the least busy server for each job.

The OpenStorage vendor plug-in must be installed on the media servers that you select.

The following is an example of the **Additional Media Server Configuration** wizard panel:

![Storage Server Configuration Wizard](image)

After you click **Next**, the **Storage Server Configuration Summary** panel appears.
6 On the **Storage Server Configuration Summary** panel, verify the selections. If OK, click **Next** to configure the storage server.

The following is an example of the wizard panel:

![Image of Storage Server Configuration Wizard]

After you click **Next**, the **Storage Server Configuration Status** panel appears.
The Storage Server Configuration Status wizard panel describes the status of the operation.

The following is an example of the Storage Server Configuration Status wizard panel:

After the storage server is created, you can do the following:
Configure a disk pool
Ensure that Create a disk pool using the storage server that you have just created is selected and then click Next.
Continue to the next step.

Exit
Click Close.
You can configure a disk pool at another time.
See "Configuring an OpenStorage disk pool for backups" on page 44.
8 The **Select Disk Pool Properties and Volumes** panel displays the volumes available on the storage server.

The following is an example of the wizard panel for a disk appliance that exposes volumes to NetBackup for backups:

![Select Disk Pool Properties and Volumes panel](image)

Select the volumes for the disk pool and then click **Next**. The **Additional Disk Pool Information** wizard panel appears.
On the **Additional Disk Pool Information** panel, enter the values for the disk pool and then click **Next**.

See “**OpenStorage disk pool properties**” on page 51.

The following is an example of the wizard panel:

The wizard **Summary** panel appears after you click **Next**.
10 On the **Summary** panel, verify the selections. To change values, click **Back** to return to the previous wizard panel. If the selections are OK, click **Next**.

The following is an example of the wizard panel:

![Storage Server Configuration Wizard](image)

After you click **Next**, the **Disk Pool Configuration Status** wizard panel appears.
The Disk Pool Configuration Status wizard panel describes the progress of the operation.

The following is an example of the wizard panel:

![Disk Pool Configuration Status wizard panel](image)

After the disk pool is created, you can do the following:

Configure a storage unit Ensure that **Create a storage unit using the disk pool that you have just created** is selected and then click **Next**. The **Storage Unit Creation** wizard panel appears. Continue to the next step.
Exit

Click Close.

You can configure one or more storage units later.

See “Configuring an OpenStorage storage unit” on page 53.

12 On the Storage Unit Creation panel, enter the appropriate information for the storage unit.

The following is an example of the wizard panel:

See “OpenStorage storage unit properties” on page 55.

Click Next to create the storage unit. After NetBackup configures the storage unit, the Finished panel appears.

13 On the Finished panel click Finish to exit from the wizard.
When you create a disk pool, you specify the following:

- The storage server.
  For OpenStorage, the disk appliance is the storage server.
- The disk volume or volumes to include in the pool.
- The disk pool properties.
  See “OpenStorage disk pool properties” on page 51.

Veritas recommends that disk volume and disk pool names be unique across your enterprise.

See “Configuring an OpenStorage storage server for backups” on page 31.

To configure an OpenStorage disk pool by using the wizard

1. In the NetBackup Administration Console, select either NetBackup Management or Media and Device Management.

2. From the list of wizards in the right pane, click Configure Disk Pool.
3 On the **Welcome** panel, the types of disk pools that you can configure depend on the options for which you are licensed.

The following is an example of the wizard panel:

Select **OpenStorage (VendorName)** and then click **Next**. The **Storage Server Selection** wizard panel appears.
On the **Storage Server Selection** panel, the OpenStorage storage servers that you have configured already appear in the **Storage server** list.

The following is an example of the wizard panel:

Select the storage server that hosts the storage for this disk pool and then click **Next**. The **Select Disk Pool Properties and Volumes** wizard panel appears.
5  The **Select Disk Pool Properties and Volumes** panel displays the volumes available on the storage server.

The following is an example of the wizard panel for an appliance that exposes volumes to NetBackup for backups:

Select the volumes for the disk pool and then click **Next**. The **Additional Disk Pool Information** wizard panel appears.
6 On the **Additional Disk Pool Information** panel, enter the values for the disk pool and then click **Next**.

See “**OpenStorage disk pool properties**” on page 51.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard]

The wizard **Summary** panel appears after you click **Next**.
7 On the **Summary** panel, verify the selections. To change values, click **Back** to return to the previous wizard panel. If the selections are OK, click **Next**.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard](image_url)

When you click **Next**, the **Disk Pool Configuration Status** wizard panel appears.
8 The Disk Pool Configuration Status wizard panel describes the progress of the operation.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard](image)

After the disk pool is created, you can do the following:

- **Configure a storage unit**
  
  Ensure that **Create a storage unit using the disk pool that you have just created** is selected and then click **Next**. The **Storage Unit Creation** wizard panel appears. Continue to the next step.

- **Exit**
  
  Click **Close**.

You can configure one or more storage units later.

See "Configuring an OpenStorage storage unit" on page 53.
9 On the **Storage Unit Creation** panel, enter the appropriate information for the storage unit.

See “OpenStorage storage unit properties” on page 55.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard](image)

Click **Next** to create the storage unit. After NetBackup configures the storage unit, the **Finished** panel appears.

10 On the **Finished** panel, click **Finish** to exit from the wizard.

**OpenStorage disk pool properties**

The properties of an OpenStorage disk pool may vary depending on the purpose the disk pool. The following table describes the possible properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The disk pool name.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Storage server</td>
<td>The storage server name. For disk appliance storage, the storage server is the disk appliance host.</td>
</tr>
<tr>
<td>Replication source</td>
<td>Indicates that the disk pool is a source for replication.</td>
</tr>
<tr>
<td>Replication target</td>
<td>Indicates that the disk pool is a target for replication.</td>
</tr>
<tr>
<td>Disk volumes</td>
<td>For disk appliance storage, the disk volumes that comprise the disk pool.</td>
</tr>
<tr>
<td>Total size</td>
<td>The total amount of space available in the disk pool.</td>
</tr>
<tr>
<td>Total raw size</td>
<td>The total raw, unformatted size of the storage in the disk pool. The storage host may or may not expose the raw size of the storage.</td>
</tr>
<tr>
<td>Comment</td>
<td>A comment that is associated with the disk pool.</td>
</tr>
<tr>
<td>High water mark</td>
<td>The High water mark setting is a threshold that triggers the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ When an individual volume in the disk pool reaches the High water mark, NetBackup considers the volume full. NetBackup chooses a different volume in the disk pool to write backup images to.</td>
</tr>
<tr>
<td></td>
<td>■ When all volumes in the disk pool reach the High water mark, the disk pool is considered full. NetBackup fails any backup jobs that are assigned to a storage unit in which the disk pool is full. NetBackup also does not assign new jobs to a storage unit in which the disk pool is full.</td>
</tr>
<tr>
<td></td>
<td>■ NetBackup begins image cleanup when a volume reaches the High water mark; image cleanup expires the images that are no longer valid. For a disk pool that is full, NetBackup again assigns jobs to the storage unit when image cleanup reduces any disk volume's capacity to less than the High water mark.</td>
</tr>
<tr>
<td></td>
<td>The default is 98%.</td>
</tr>
<tr>
<td>Low water mark</td>
<td>The Low water mark is a threshold at which NetBackup stops image cleanup. The Low water mark setting cannot be greater than or equal to the High water mark setting. The default is 80%.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Limit I/O streams</td>
<td>Select to limit the number of read and write streams (that is, jobs) for each volume in the disk pool. A job may read backup images or write backup images. By default, there is no limit.</td>
</tr>
<tr>
<td></td>
<td>When the limit is reached, NetBackup chooses another volume for write operations, if available. If not available, NetBackup queues jobs until a volume is available.</td>
</tr>
<tr>
<td></td>
<td>Too many streams may degrade performance because of disk thrashing. Disk thrashing is excessive swapping of data between RAM and a hard disk drive. Fewer streams can improve throughput, which may increase the number of jobs that complete in a specific time period.</td>
</tr>
<tr>
<td>per volume</td>
<td>Select or enter the number of read and write streams to allow per volume.</td>
</tr>
<tr>
<td></td>
<td>Many factors affect the optimal number of streams. Factors include but are not limited to disk speed, CPU speed, and the amount of memory.</td>
</tr>
</tbody>
</table>

## Configuring an OpenStorage storage unit

Create one or more storage units that reference each disk pool that you configure.

A storage unit inherits the properties of the disk pool. If the storage unit inherits replication properties, the properties signal to a NetBackup storage lifecycle policy the intended purpose of the storage unit and the disk pool. Auto Image Replication requires storage lifecycle policies. Replication properties may not exist or be exposed to NetBackup by the vendor plug-in.

See “About OpenStorage disk pools for backups” on page 14.

The Disk Pool Configuration Wizard lets you create a storage unit; therefore, you may have created a storage unit when you created a disk pool. To determine if storage units exist for the disk pool, see the NetBackup Management > Storage > Storage Units window of the NetBackup Administration Console.

See “About OpenStorage storage unit recommendations” on page 57.
To create a storage unit from the Actions menu

1. In the NetBackup Administration Console, in the left pane, select NetBackup Management > Storage > Storage Units.

2. Click Actions > New > Storage Unit.

3. Complete the fields in the New Storage Unit dialog box.

4. Click OK.
OpenStorage storage unit properties

The configuration options for a OpenStorage disk pool storage unit are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage unit name</td>
<td>Provide a unique name for the new storage unit. The name can describe the type of storage. The storage unit name is the name used to specify a storage unit for policies and schedules. The storage unit name cannot be changed after creation.</td>
</tr>
<tr>
<td>Storage unit type</td>
<td>Select Disk as the storage unit type.</td>
</tr>
<tr>
<td>Disk type</td>
<td>Select OpenStorage (Solution) for the disk type. Solution is a string provided by the storage vendor that may represent the vendor, the vendor device, or something else that is meaningful.</td>
</tr>
<tr>
<td>Disk pool configured for</td>
<td>Select Backup for the disk type.</td>
</tr>
<tr>
<td>Replication source</td>
<td>Select this option to filter the available disk pools to show only those that contain replication source volumes.</td>
</tr>
<tr>
<td>Replication target</td>
<td>Select this option to filter the available disk pools to show only those that contain replication target volumes. A disk volume can be both a replication source and a replication target.</td>
</tr>
<tr>
<td>Disk pool</td>
<td>Select the disk pool that contains the storage for this storage unit. If you select a replication property, NetBackup filters the disk pools that appear in the Disk pool list. Otherwise, all disk pools of the specified Disk type appear. If no disk pools are configured, no disk pools appear in the list. After you select a disk pool, you can click View Properties.</td>
</tr>
</tbody>
</table>

Table 5-3 OpenStorage storage unit properties
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Media server**         | Specify the NetBackup media servers that can move data to the storage server for this storage unit. (For OpenStorage, NetBackup media servers function as data movers.) Only the media servers that are configured as data movers for the OpenStorage implementation appear in the media server list. If a media server does not appear in the list, verify that the software plug-in is installed and that logon credentials are created. Specify the media server or servers as follows:  
  - To allow any media server in the media server list to move data to the storage server, check **Use Any Available Media Server**.  
    If you configure more media server data movers in the future, you do not have to update the storage unit. After you install the plug-in and configure the credentials, NetBackup automatically uses the media servers for the backups that are sent to the storage unit.  
  - To restrict the media servers that can move data to the storage server, check **Only Use The Following Media Servers**. Then select the media servers that are allowed to move the data. Any media server in the list can receive data from the storage server; it does not have to be selected. A media server receives data for restore jobs and for storage monitoring purposes. NetBackup selects the media server to use when the policy runs. |
| **Maximum fragment size**| Specify the largest fragment size that NetBackup can create to store backups. The default maximum fragment size for a disk storage unit is 524,288 megabytes. To specify a maximum fragment size other than the default, enter a value from 20 megabytes to 524,288 megabytes. Backups to disk are usually fragmented to ensure that the backup does not exceed the maximum size that the file system allows. If an error occurs in a backup, the entire backup is discarded. The backup restarts from the beginning, not from the fragment where the error occurred. (An exception is for backups for which checkpoint and restart are enabled. In that case, fragments before and up to the last checkpoint are retained; the fragments after the last checkpoint are discarded.) |
### Table 5-3 OpenStorage storage unit properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum concurrent jobs</td>
<td>Specify the maximum number of jobs that NetBackup can send to a disk storage unit at one time. (Default: one job. The job count can range from 0 to 256.)</td>
</tr>
<tr>
<td></td>
<td>NetBackup queues jobs until the storage unit is available. If three backup jobs are ready to be sent to the storage unit and <strong>Maximum concurrent jobs</strong> is set to two, NetBackup starts the first two jobs. NetBackup queues the third job. If a job contains multiple copies, each copy applies toward the <strong>Maximum concurrent jobs</strong> count.</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum concurrent jobs</strong> controls the traffic for backup and duplication jobs but not restore jobs. The count applies to all servers in the storage unit, not per server. If you select multiple media servers in the storage unit and 1 for <strong>Maximum concurrent jobs</strong>, only one job runs at a time.</td>
</tr>
<tr>
<td></td>
<td>The number to enter depends on the available disk space and the server's ability to run multiple backup processes.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> A <strong>Maximum concurrent jobs</strong> setting of 0 disables the storage unit.</td>
</tr>
<tr>
<td></td>
<td>See “About throttling OpenStorage traffic to the media servers” on page 59.</td>
</tr>
</tbody>
</table>

### About OpenStorage storage unit recommendations

You can use storage unit properties to control how NetBackup moves backup and duplication data.

For example, you can accomplish the following objectives by using the storage unit **Media server** setting:

- Configure a favorable client-to-server ratio for important clients.
  
  See “About configuring a favorable client-to-server ratio with OpenStorage” on page 57.

- Separate SAN client traffic from other traffic.
  
  See “About separating OpenStorage SAN client traffic” on page 58.

You also can use the storage unit **Maximum concurrent jobs** setting to control the backup or the duplication traffic that is sent to the media servers.

See “About throttling OpenStorage traffic to the media servers” on page 59.

### About configuring a favorable client-to-server ratio with OpenStorage

For a favorable client-to-server ratio, you can use one disk pool and configure multiple storage units to separate your backup traffic. Because all storage units use the same disk pool, you do not have to partition the storage.
For example, assume that you have 100 important clients, 500 regular clients, and four media servers. You can use two media servers to back up your most important clients and two media servers to back up your regular clients.

The following example describes how to configure a favorable client-to-server ratio:

- Configure the media servers for OpenStorage and configure the storage.
- Configure a disk pool.
- Configure a storage unit for your most important clients (such as STU-GOLD). Select the disk pool. Select **Only use the following media servers**. Select two media servers to use for your important backups.
- Configure a backup policy for the 100 important clients and select the STU-GOLD storage unit. The media servers that are specified in the storage unit move the client data to the storage server.
- Configure another storage unit (such as STU-SILVER). Select the same disk pool. Select **Only use the following media servers**. Select the other two media servers.
- Configure a backup policy for the 500 regular clients and select the STU-SILVER storage unit. The media servers that are specified in the storage unit move the client data to the storage server.

Backup traffic is routed to the wanted data movers by the storage unit settings.

---

**Note:** NetBackup uses storage units for media server selection for write activity (backups and duplications) only. For restores, NetBackup chooses among all media servers that have logon credentials to the storage server.

---

**About separating OpenStorage SAN client traffic**

If you use the NetBackup Fibre Transport option, you can use one disk pool and multiple storage units to manage backup traffic. You can separate the NetBackup SAN client traffic from the regular NetBackup client traffic. Because all storage units use the same disk pool, you do not have to partition the storage.

The following example describes how to separate SAN client traffic:

- Configure the FT media servers and the regular media servers for OpenStorage and configure the storage.
- Configure a disk pool.
- Define a storage unit (such as STU-FT). Select the disk pool. Select **Only use the following media servers**. Select the FT media servers that connect to the SAN clients.
Create a backup policy for the SAN clients and select the STU-FT storage unit.

Define another storage unit (such as STU-LAN). Select the same disk pool. Select Only use the following media servers. Select the media servers with LAN connectivity to the regular clients.

Create a backup policy for the regular clients and select the STU-LAN storage unit.

Backup traffic is routed to the wanted data movers by the storage unit settings.

This scenario assumes that the SAN clients are a subset of your client base. It also assumes that the media servers with LAN connectivity to the regular clients also have SAN connectivity to the storage.

**Note:** NetBackup uses storage units for media server selection for write activity (backups and duplications) only. For restores, NetBackup chooses among all media servers that have logon credentials to the storage server.

### About throttling OpenStorage traffic to the media servers

You can use the **Maximum concurrent jobs** settings on disk pool storage units to throttle the traffic to the media servers. Effectively, this setting also directs higher loads to specific media servers when you use multiple storage units for the same disk pool. A higher number of concurrent jobs means that the disk can be busier than if the number is lower.

For example, two storage units use the same set of media servers. One of the storage units (STU-GOLD) has a higher **Maximum concurrent jobs** setting than the other (STU-SILVER). More client backups occur for the storage unit with the higher **Maximum concurrent jobs** setting.

## Configuring OpenStorage optimized synthetic backups

Use the following procedure to configure optimized synthetic backups.

If NetBackup cannot produce the optimized synthetic backup, NetBackup creates the more data-movement intensive synthetic backup.

See “About OpenStorage optimized synthetic backups” on page 16.

**To configure optimized synthetic backup**

1. Configure a **Standard** or **MS-Windows** backup policy.

2. Select the **Synthetic backup** attribute on the **ScheduleAttribute** tab.
Configuring OpenStorage direct to tape

To configure OpenStorage direct to tape, you must perform multiple procedures on multiple computers. These procedures are in addition to the procedures to install and configure the disk appliance and OpenStorage.

See “About OpenStorage direct to tape” on page 18.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Learn about OpenStorage direct to tape</td>
<td>See “About OpenStorage direct to tape” on page 18.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Install and configure the NDMP tape server hosts and storage devices</td>
<td>See the NetBackup for NDMP Administrator’s Guide.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you upgraded a disk appliance so it supports the Veritas OpenStorage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>copy to tape specification, you must reconfigure the storage server in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NetBackup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Configuring an OpenStorage storage server for backups” on page 31.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Reconfigure the storage server</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step 4</td>
<td>Install the NetBackup for NDMP software</td>
<td>Install the NetBackup for NDMP software on each media server you use for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>direct to tape.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About media server recommendations for OpenStorage direct to tape”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>on page 22.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About media server requirements for OpenStorage direct to tape”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>on page 21.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the NetBackup for NDMP Administrator’s Guide.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You must enter a license that activates NDMP on those media servers. The</td>
</tr>
<tr>
<td></td>
<td></td>
<td>license that activates OpenStorage also activates NetBackup for NDMP.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Configure NDMP host credentials</td>
<td>Configure logon credentials in NetBackup for the NDMP hosts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About NDMP requirements for OpenStorage direct to tape” on page 19.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the NetBackup for NDMP Administrator’s Guide.</td>
</tr>
</tbody>
</table>
Table 5-4  OpenStorage direct to tape configuration overview (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 6</td>
<td>Configure the NetBackup storage units</td>
<td>The storage units must be configured as NDMP storage units, and they must use the NDMP tape storage as their destination. You do not have to include the write side media servers explicitly in the storage unit. If you configure <em>Any Available</em>, when the job runs NetBackup selects a media server that has the logon credentials for the NDMP tape server. See the <em>NetBackup Administrator's Guide, Volume I</em>.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Configure the copy to tape process</td>
<td>First ensure that all requirements are met. See “About NDMP requirements for OpenStorage direct to tape” on page 19. Then, use one of the following methods for direct to tape: Create a storage lifecycle policy to create the backup and to duplicate the backup images automatically. For the <em>Backup destination Storage unit</em>, select the storage unit for the disk pool on one appliance. For the <em>Duplication destination Storage unit</em>, select the NDMP storage unit. See the <em>NetBackup Administrator’s Guide, Volume I</em>. Create a Vault policy to copy images automatically. On the <em>Profile dialog box Choose Backups tab</em>, choose the backup images in the source disk pool on one appliance. For the <em>Destination Storage unit</em> on the <em>Duplication tab</em>, select the NDMP storage unit. See the <em>NetBackup Vault Administrator’s Guide</em>. Use the <em>Duplicate option</em> in the <em>Catalog node of the NetBackup Administration Console</em>. Select the NDMP storage unit as the destination for the duplication. Use the <em>Storage unit field</em> in the <em>Setup Duplication Variables</em> dialog box. See the <em>NetBackup Administrator’s Guide, Volume I</em>. Use the <em>NetBackup bpduplicate command</em> to duplicate images on the disk appliance to an NDMP storage unit. See <em>NetBackup Commands Reference Guide</em>.</td>
</tr>
</tbody>
</table>

Configuring optimized duplication to an OpenStorage device within the same NetBackup domain

You can configure optimized duplication from one disk appliance to another disk appliance of the same type.
A NetBackup media server initiates and manages the duplication between appliances. After the duplication completes, the media server connects to the destination appliance to verify the image copy. NetBackup maintains records of the image copies and their locations in the NetBackup catalog.

### Table 5-5  To configure optimized duplication of deduplicated data

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Ensure that all requirements are met.</td>
<td>See “About OpenStorage optimized duplication within the same domain” on page 63.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure optimized duplication behaviors.</td>
<td>Optionally, you can configure the optimized duplication behavior. See “Configuring NetBackup optimized duplication or replication behavior” on page 65. See “About throttling OpenStorage traffic to the media servers” on page 59.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select the media server in common.</td>
<td>In the storage unit for the destination disk pool, select Only use the following media servers. Then, select the media server or media servers that are common to both the source storage server and the destination storage server. If you select more than one, NetBackup balances the job load among them. See “Configuring an OpenStorage storage unit” on page 53.</td>
</tr>
</tbody>
</table>
| Step 4 | Configure a storage lifecycle policy for the duplication | Configure a storage lifecycle policy only if you want to use one to duplicate images. The storage lifecycle policy manages both the backup jobs and the duplication jobs. Configure the lifecycle policy in the OpenStorage environment that performs your normal backups. When you configure the storage lifecycle policy, do the following:  
  - For the Backup destination, select the Storage unit that is the target of your backups. The disk appliance for the storage unit contains the primary backup copies; they are the source images for the duplication operation.  
  - For the Duplication destination, select the Storage unit for the disk pool on another appliance. You can apply separate retention periods to each copy. For example, you can retain the source image for three weeks and the destination copy for a longer period of time. If you delete the source image, the copy is not deleted. See “About storage lifecycle policies” on page 79. See “Creating a storage lifecycle policy” on page 82. |
Table 5-5

To configure optimized duplication of deduplicated data (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 5</td>
<td>Configure a backup policy</td>
<td>Configure a backup policy only if you use a storage lifecycle policy to manage the duplication. Configure a policy to back up your clients. Select that storage lifecycle policy in the Policy storage field of the Policy Attributes tab. See “Creating a backup policy” on page 87.</td>
</tr>
</tbody>
</table>
| Step 6 | Configure NetBackup Vault for the duplication | Configure Vault duplication only if you use NetBackup Vault to duplicate the images. Configure Vault in the deduplication environment that performs your normal backups. Do not configure it in the environment that contains the copies. A Vault policy. For Vault, you must configure a Vault profile and a Vault policy.  
  - On the Vault Profile dialog box Choose Backups tab, choose the backup images in the source disk pool.  
  - On the Vault Profile dialog box Duplication tab, select the destination storage unit in the Destination Storage unit field.  
  - Configure a Vault policy to schedule the duplication jobs. A Vault policy is a NetBackup policy that is configured to run Vault jobs. Select the profile you created for the OpenStorage duplication job. See the NetBackup Vault Administrator’s Guide. |
| Step 7 | Duplicate by using the bpduplicate command | Use the NetBackup bpduplicate command only if you want to copy images manually. Duplicate from the source storage to the destination storage. See NetBackup Commands Reference Guide. |

About OpenStorage optimized duplication within the same domain

With duplication to another disk appliance within the same domain, the disk appliances manage the deduplication. The ability to duplicate backups to storage in other locations, often across various geographical sites, helps facilitate disaster recovery.

The following are some benefits of optimized, off-host duplication:

- Reduced workload on the NetBackup media servers. More backups can be performed.
Faster duplication. Duplication can occur in the background, simultaneously with ongoing backup jobs.

Reduced bandwidth. If the appliance supports deduplication, the copy process may send only changed blocks.

NetBackup supports two optimized duplication methods for OpenStorage. The optimized duplication method that NetBackup uses depends on the capability that the vendor’s OpenStorage plug-in exposes, as follows:

Optimized duplication
NetBackup optimized duplication is extent-based; NetBackup transfers data in 256-KB chunks.

For optimized duplication, the NetBackup `bpstsinfo` command output that shows the storage server capabilities shows the following flag:

```plaintext
STS_SRVC_COPY_EXTENT
```

Whole image optimized duplication
Whole image optimized duplication uses the storage unit Maximum fragment size for the data chunk size. Veritas refers to this type of operation as whole image optimized duplication because an entire NetBackup image fragment is transferred.

Because larger chunks of data are transferred, fewer copy management requests occur and performance improves. Also, the storage device controls progress reporting. The storage device may report progress when system load is low rather than consume the resources that are better used for duplication. Or, the storage device may report progress at short intervals, updating the NetBackup user as frequently as NetBackup would for extent-based optimized duplication.

For whole image optimized duplication, the NetBackup `bpstsinfo` command output that shows the storage server capabilities shows the following two flags:

```plaintext
STS_SRVC_COPY_EXTENT
STS_SRVC_COPY_EXTENT_WHOLEIMAGE
```

The following is the syntax for the `bpstsinfo` command that shows the storage server capabilities:

```plaintext
bpstsinfo -storage_server host_name -stype vendor_string
```

More information about the `bpstsinfo` command is available.

See the NetBackup Commands Reference Guide:
The following are the requirements and limitations of optimized duplication with the same domain:

**Optimized duplication requirements**

- The vendor must expose the off-host data movement capability in their plug-in.
- Both the source and the destination disk pools must be the same OpenStorage vendor type.
- One or more NetBackup media servers must connect to the source appliance and the destination appliance.

**Optimized duplication limitations**

- If the optimized duplication fails, the job is not retried. To configure NetBackup to do normal duplication if the optimized job fails, add the following entry to the `bp.conf` file on the NetBackup master server:

  ```
  RESUME_ORIG_DUP_ON_OPT_DUP_FAIL = TRUE
  ```

- The copy operation uses the maximum fragment size of the source storage unit, not the setting for the destination storage unit. The optimized duplication copies the image fragments as is. For greater efficiency, the duplication does not resize and reshuffle the images into a different set of fragments on the destination storage unit.
- To confirm the image copy, a media server must have connectivity to the destination appliance.
- A storage unit group cannot be a destination for optimized duplication. The destination must be a storage unit that represents an OpenStorage appliance of the same type as the source appliance.

### Configuring NetBackup optimized duplication or replication behavior

You can configure some optimized duplication and replication behaviors for NetBackup. The behaviors depend on how NetBackup duplicates the images, as described in the following table.
Table 5-6 Optimized duplication behavior

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplication by using NetBackup Vault or the bpduplicate command</td>
<td>If you use NetBackup Vault or the <code>bpduplicate</code> command for duplication, you can configure the following behaviors:</td>
</tr>
<tr>
<td></td>
<td>■ Number of optimized duplication attempts.</td>
</tr>
<tr>
<td></td>
<td>You can change the number of times NetBackup retries an optimized duplication job before it fails the jobs.</td>
</tr>
<tr>
<td></td>
<td>See “To configure the number of duplication attempts” on page 66.</td>
</tr>
<tr>
<td></td>
<td>■ Optimized duplication failover.</td>
</tr>
<tr>
<td></td>
<td>By default, if an optimized duplication job fails, NetBackup does not run the job again.</td>
</tr>
<tr>
<td></td>
<td>You can configure NetBackup to use normal duplication if an optimized duplication job fails.</td>
</tr>
<tr>
<td></td>
<td>See “To configure optimized duplication failover” on page 67.</td>
</tr>
<tr>
<td>Duplication or replication by using a storage lifecycle policy</td>
<td>If a storage lifecycle policy optimized duplication or replication job fails, NetBackup waits 2 hours and retries the job again.</td>
</tr>
<tr>
<td></td>
<td>NetBackup repeats the retry behavior until the job succeeds or the source backup image expire.</td>
</tr>
<tr>
<td></td>
<td>You can change the number of hours for the wait period.</td>
</tr>
<tr>
<td></td>
<td>See “To configure the storage lifecycle policy wait period” on page 67.</td>
</tr>
<tr>
<td>If you use a storage lifecycle policy for duplication, do not configure optimized duplication behavior for NetBackup Vault or the <code>bpduplicate</code> command, and vice versa. NetBackup behavior may not be predictable.</td>
<td></td>
</tr>
</tbody>
</table>

**Caution:** These settings affect all optimized duplication jobs; they are not limited to a specific NetBackup storage option.

**To configure the number of duplication attempts**

- On the master server, create a file named `OPT_DUP_BUSY_RETRY_LIMIT`. Add an integer to the file that specifies the number of times to retry the job before NetBackup fails the job.
  
  The file must reside on the master server in the following directory (depending on the operating system):
  
  - **UNIX:** `/usr/openv/netbackup/db/config`
To configure optimized duplication failover

- On the master server, add the following configuration option:

  `RESUME_ORIG_DUP_ON_OPT_DUP_FAIL = TRUE`

  See “Setting NetBackup configuration options by using the command line” on page 67.

  Alternatively on UNIX systems, you can add the entry to the `bp.conf` file on the NetBackup master server.

To configure the storage lifecycle policy wait period

1. In the NetBackup Administration Console, expand NetBackup Management > Host Properties > Master Servers. Select the master server, then on the Actions menu click Properties.
2. Select SLP Parameters.
3. Change the Extended image retry interval to the new value.
4. Click OK.

Setting NetBackup configuration options by using the command line

Veritas recommends that you use the NetBackup Administration Console Host Properties to configure NetBackup properties.

However, some properties cannot be set by using the Administration Console. You can set those properties by using the following NetBackup commands:

For a NetBackup server: `bpsetconfig`
For a NetBackup client: `nbsetconfig`

Configuration options are key and value pairs, as shown in the following examples:

- `CLIENT_READ_TIMEOUT = 300`
- `LOCAL_CACHE = NO`
- `RESUME_ORIG_DUP_ON_OPT_DUP_FAIL = TRUE`
- `SERVER = server1.example.com`

You can specify some options multiple times, such as the `SERVER` option.
To set configuration options by using the command line

1  In a command window or shell window on the host on which you want to set the property, invoke the appropriate command. The command depends on the operating system and the NetBackup host type (client or server), as follows:

   UNIX   On a NetBackup client:
           /usr/openv/netbackup/bin/nbsetconfig

           On a NetBackup server:
           /usr/openv/netbackup/bin/admincmd/bpsetconfig

   Windows On a NetBackup client:
           install_path\NetBackup\bin\nbsetconfig.exe

           On a NetBackup server:
           install_path\NetBackup\bin\admincmd\bpsetconfig.exe

2  At the command prompt, enter the key and the value pairs of the configuration options that you want to set, one pair per line.

   You can change existing key and value pairs.

   You can add key and value pairs.

   Ensure that you understand the values that are allowed and the format of any new options that you add.

3  To save the configuration changes, type the following, depending on the operating system:

   Windows: Ctrl + Z Enter

   UNIX: Ctrl + D Enter

Configuring replication to an OpenStorage device in a different domain

For the third-party vendor appliance storage, NetBackup supports replication if the vendor exposes that functionality. The source storage and the target storage must be the same appliance type.

Table 5-7 describes the tasks that are required to replicate backup images from an OpenStorage disk appliance to another one of the same types in a different NetBackup domain.
Table 5-7 NetBackup OpenStorage replication tasks

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Learn about NetBackup Auto Image Replication</td>
<td>See “About NetBackup Auto Image Replication” on page 69.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Define the relationship between the domains</td>
<td>Define the relationship between the domains so that the originating domain knows where to send the data. See “About the domain relationship for replication” on page 74.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Configure a storage lifecycle policy</td>
<td>See “About storage lifecycle policies” on page 79. See “About the storage lifecycle policies required for Auto Image Replication” on page 80. See “Creating a storage lifecycle policy” on page 82.</td>
</tr>
</tbody>
</table>

About NetBackup Auto Image Replication

The backups that are generated in one NetBackup domain can be replicated to storage in one or more target NetBackup domains. This process is referred to as Auto Image Replication.

The ability to replicate backups to storage in other NetBackup domains, often across various geographical sites, helps facilitate the following disaster recovery needs:

- **One-to-one model**
  A single production datacenter can back up to a disaster recovery site.

- **One-to-many model**
  A single production datacenter can back up to multiple disaster recovery sites. See “One-to-many Auto Image Replication model” on page 71.

- **Many-to-one model**
  Remote offices in multiple domains can back up to a storage device in a single domain.

- **Many-to-many model**
  Remote datacenters in multiple domains can back up multiple disaster recovery sites.

NetBackup supports Auto Image Replication from an OpenStorage disk pool in one NetBackup domain to an OpenStorage disk pool in another domain. The OpenStorage devices that host those disk pools must be the same type.
Notes about Auto Image Replication

- Although Auto Image Replication is a disaster recovery solution, you cannot restore to clients in the primary (or originating) domain from the target master domain.

- Auto Image Replication does not support synthetic backups or optimized synthetic backups.

- Auto Image Replication does not support spanning volumes in a disk pool. NetBackup fails backup jobs to the disk pools that span volumes if the backup job is in a storage lifecycle policy that also contains a replication operation.

- Auto Image Replication does not support replicating from a storage unit group. That is, the source copy cannot be in a storage unit group.

- The ability to perform Auto Image Replication between different versions of NetBackup does not overrule the basic image compatibility rules. For example, a database backup that was taken in one NetBackup domain can be replicated to a NetBackup domain of an earlier version. However, the older server may not be able to successfully restore from the newer image. See the following article for information about version compatibility and interoperability:
  http://www.netbackup.com/compatibility

- Synchronize the clocks of the master servers in the source and the target domains so that the master server in the target domain can import the images as soon as they are ready. The master server in the target domain cannot import an image until the image creation time is reached. Time zone differences are not a factor because the images use Coordinated Universal Time (UTC).

Process Overview

Table 5-8 is an overview of the process, generally describing the events in the originating and target domains.

NetBackup uses storage lifecycle policies in the source domain and the target domain to manage the Auto Image Replication operations.

See “About the storage lifecycle policies required for Auto Image Replication” on page 80.
### Auto Image Replication process overview

<table>
<thead>
<tr>
<th>Event</th>
<th>Domain in which event occurs</th>
<th>Event description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Originating master server (Domain 1)</td>
<td>Clients are backed up according to a backup policy that indicates a storage lifecycle policy as the <strong>Policy storage</strong> selection. The SLP must include at least one <strong>Replication</strong> operation to similar storage in the target domain.</td>
</tr>
<tr>
<td>2</td>
<td>Target master server (Domain 2)</td>
<td>The storage server in the target domain recognizes that a replication event has occurred. It notifies the NetBackup master server in the target domain.</td>
</tr>
<tr>
<td>3</td>
<td>Target master server (Domain 2)</td>
<td>NetBackup imports the image immediately, based on an SLP that contains an import operation. NetBackup can import the image quickly because the metadata is replicated as part of the image. (This import process is not the same as the import process available in the <strong>Catalog</strong> utility.)</td>
</tr>
<tr>
<td>4</td>
<td>Target master server (Domain 2)</td>
<td>After the image is imported into the target domain, NetBackup continues to manage the copies in that domain. Depending on the configuration, the media server in Domain 2 can replicate the images to a media server in Domain 3.</td>
</tr>
</tbody>
</table>

### One-to-many Auto Image Replication model

In this configuration, all copies are made in parallel. The copies are made within the context of one NetBackup job and simultaneously within the originating storage server context. If one target storage server fails, the entire job fails and is retried later.

All copies have the same **Target Retention**. To achieve different **Target Retention** settings in each target master server domain, either create multiple source copies or cascade duplication to target master servers.

### Cascading Auto Image Replication model

Replications can be cascaded from the originating domain to multiple domains. Storage lifecycle policies are set up in each domain to anticipate the originating image, import it and then replicate it to the next target master.

*Figure 5-1* represents the following cascading configuration across three domains:

- The image is created in Domain 1, and then replicated to the target Domain 2.
- The image is imported in Domain 2, and then replicated to a target Domain 3.
- The image is then imported into Domain 3.
In the cascading model, the originating master server for Domain 2 and Domain 3 is the master server in Domain 1.

**Note:** When the image is replicated in Domain 3, the replication notification event indicates that the master server in Domain 2 is the originating master server. However, after the image is imported successfully into Domain 3, NetBackup correctly indicates that the originating master server is in Domain 1.

The cascading model presents a special case for the Import SLP that replicates the imported copy to a target master. (This master server that is neither the first nor the last in the string of target master servers.)

The Import SLP must include at least one operation that uses a **Fixed** retention type and at least one operation that uses a **Target Retention** type. So that the Import SLP can satisfy these requirements, the import operation must use a **Target Retention**.

**Table 5-9** shows the difference in the import operation setup.
### Table 5-9  Import operation difference in an SLP configured to replicate the imported copy

<table>
<thead>
<tr>
<th>Import operation criteria</th>
<th>Import operation in a cascading model</th>
</tr>
</thead>
<tbody>
<tr>
<td>The first operation must be an import operation.</td>
<td>Same; no difference.</td>
</tr>
<tr>
<td>A replication to target master must use a <strong>Fixed</strong> retention type</td>
<td>Same; no difference.</td>
</tr>
<tr>
<td>At least one operation must use the <strong>Target retention</strong>.</td>
<td>Here is the difference: To meet the criteria, the import operation must use <strong>Target retention</strong>.</td>
</tr>
</tbody>
</table>

The target retention is embedded in the source image.

In the cascading model that is represented in [Figure 5-1](#), all copies have the same **Target Retention**—the **Target Retention** indicated in Domain 1.

For the copy in Domain 3 to have a different target retention, add an intermediary replication operation to the Domain 2 storage lifecycle policy. The intermediary replication operation acts as the source for the replication to target master. Since the target retention is embedded in the source image, the copy in Domain 3 honors the retention level that is set for the intermediary replication operation.
About the domain relationship for replication

For third-party vendor appliance storage that is exposed through the OpenStorage API, the disk appliance manages the storage. The relationship between the originating domain and the target domain or domains is established by using the storage vendor's tools.

The originating NetBackup domain has no knowledge of the storage server in the target domain or domains. When the appliances are configured properly, NetBackup images on the originating disk appliance are replicated automatically to the target disk appliance. That disk appliance uses the OpenStorage API to notify NetBackup that a replication event occurred. NetBackup then imports those images.

NetBackup manages the lifecycle of the backup images but does not manage the storage.

Configuring the disk appliance replication relationship is beyond the scope of the NetBackup documentation.

---

**Caution:** Choose the target storage server carefully. A target storage server must not also be a storage server for the originating domain.
About the replication topology for Auto Image Replication

For Auto Image Replication, the disk volumes have the properties that define the replication relationships between the volumes. The knowledge of the volume properties is considered the replication topology. The following are the replication properties that a volume can have:

**Source**
A source volume contains the backups of your clients. The volume is the source for the images that are replicated to a remote NetBackup domain. Each source volume in an originating domain has one or more replication partner target volumes in a target domain.

**Target**
A target volume in the remote domain is the replication partner of a source volume in the originating domain.

**None**
The volume does not have a replication attribute.

Your storage administrator configures the replication topology of the volumes in the storage devices. Based on the volume properties, you create homogeneous disk pools. That is, all of the volumes in a disk pool must have the same properties, and you create the disk pools to match that topology. The disk pools inherit the replication properties from the volumes that you add to them.

You should work with your storage administrator to understand the topology so you can create the proper disk pools. You also should work with your storage administrator to understand any changes that are made to the replication topology.

NetBackup discovers the topology of the volumes when you configure a disk pool. NetBackup discovers the replication topology when you configure the replication relationships. NetBackup discovers topology changes when you use the **Refresh** option of the **Change Disk Pool** dialog box.

See “Changing OpenStorage disk pool properties” on page 102.

NetBackup includes a command that can help you understand your replication topology. Use the command in the following situations:

- After you configure the replication targets.
- After you configure the storage server and before you configure disk pools.
- After changes to the volumes that comprise the storage.

See “Viewing the replication topology for Auto Image Replication” on page 76.
Viewing the replication topology for Auto Image Replication

A volume that is a source of replication must have at least one replication partner that is the target of the replication. NetBackup lets you view the replication topology of the storage.

See “About the replication topology for Auto Image Replication” on page 75.

To view the replication topology for Auto Image Replication

- Run the `bpstsinfo` command, specifying the storage server name and the server type. The following is the command syntax:
  - Windows: `install_path\NetBackup\bin\admincmd\bpstsinfo -lsuinfo -storage_server host_name -stype server_type`
  - UNIX: `/usr/openv/netbackup/bin/admincmd/bpstsinfo -lsuinfo -storage_server host_name -stype server_type`

The following are the options and arguments for the command:

- `-storage_server host_name` The name of the target storage server.
- `-stype server_type` For an OpenStorage disk appliance, the vendor provides the string for `server_type`.

Save the output to a file so that you can compare the current topology with the previous topology to determine what has changed.

See “Sample volume properties output for OpenStorage backup replication” on page 76.

Sample volume properties output for OpenStorage backup replication

The following examples show sample output from the `bpstsinfo` command for two OpenStorage devices. The first example is the output from the source disk pool that contains the client backups. The second example is from the target disk pool in the remote master server domain.

The two examples show the following:

- Volume `dv01` on storage server `pan1.example.com` is the replication source for volume `dv01` on `pan2.example.com`.
- Volume `dv02` on storage server `pan1.example.com` is the replication source for volume `dv02` on `pan2.example.com`.
- Volume `dv03` on both devices has no replication properties.
>bpstinfo -lsuinfo -storage_server pan1.example.com -stype Pan

LSU Info:
    Server Name: pan1.example.com
    LSU Name: dv01
    Allocation : STS_LSU_AT_STATIC
    Storage: STS_LSU_ST_NONE
    Description: E:\
    Configuration:
    Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |
             STS_LSUF_REP_SOURCE)
    Save As : (STS_SA_IMAGE)
    Replication Sources: 0 ( )
    Replication Targets: 1 ( Pan:pan2.example.com:dv01 )
    Maximum Transfer: 2147483647
    Block Size: 512
    Allocation Size: 0
    Size: 80525455360
    Physical Size: 0
    Bytes Used: 2285355008
    Physical Bytes Used: 0
    Resident Images: 0

LSU Info:
    Server Name: pan1.example.com
    LSU Name: dv02
    Allocation : STS_LSU_AT_STATIC
    Storage: STS_LSU_ST_NONE
    Description: E:\
    Configuration:
    Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |
             STS_LSUF_REP_SOURCE)
    Save As : (STS_SA_IMAGE)
    Replication Sources: 0 ( )
    Replication Targets: 1 ( Pan:pan2.example.com:dv02 )
    Maximum Transfer: 2147483647
    Block Size: 512
    Allocation Size: 0
    Size: 80525455360
    Physical Size: 0
    Bytes Used: 2285355008
    Physical Bytes Used: 0
    Resident Images: 0

LSU Info:
    Server Name: pan1.example.com
LSU Name: dv03
Allocation: STS_LSU_AT_STATIC
Storage: STS_LSU_ST_NONE
Description: E:\
Configuration:
Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED)
Save As: (STS_SA_IMAGE)
Replication Sources: 0 ( )
Replication Targets: 0 ( )
Maximum Transfer: 2147483647
Block Size: 512
Allocation Size: 0
Size: 80525455360
Physical Size: 0
Bytes Used: 2285355008
Physical Bytes Used: 0
Resident Images: 0

>bpstsinfo -lsuinfo -storage_server pan2.example.com -stype Pan
LSU Info:
Server Name: pan2.example.com
LSU Name: dv01
Allocation: STS_LSU_AT_STATIC
Storage: STS_LSU_ST_NONE
Description: E:\
Configuration:
Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED | STS_LSUF_REP_TARGET)
Save As: (STS_SA_IMAGE)
Replication Sources: 1 ( Pan:pan1.example.com:dv01 )
Replication Targets: 0 ( )
Maximum Transfer: 2147483647
Block Size: 512
Allocation Size: 0
Size: 80525455360
Physical Size: 0
Bytes Used: 2285355008
Physical Bytes Used: 0
Resident Images: 0

LSU Info:
Server Name: pan2.example.com
LSU Name: dv02
Allocation: STS_LSU_AT_STATIC
About storage lifecycle policies

A storage lifecycle policy (SLP) is a storage plan for a set of backups. An SLP is configured within the Storage Lifecycle Policies utility.

An SLP contains instructions in the form of storage operations, to be applied to the data that is backed up by a backup policy. Operations are added to the SLP that
determine how the data is stored, copied, replicated, and retained. NetBackup retries the copies as necessary to ensure that all copies are created.

SLPs offer the opportunity for users to assign a classification to the data at the policy level. A data classification represents a set of backup requirements, which makes it easier to configure backups for data with different requirements. For example, email data and financial data.

SLPs can be set up to provide staged backup behavior. They simplify data management by applying a prescribed behavior to all the backup images that are included in the SLP. This process allows the NetBackup administrator to leverage the advantages of disk-based backups in the near term. It also preserves the advantages of tape-based backups for long-term storage.

The SLP Parameters properties in the NetBackup Administration Console allow administrators to customize how SLPs are maintained and how SLP jobs run.

Best-practice information about SLPs appears in the following document:
http://www.veritas.com/docs/TECH208536

For more information, see the NetBackup Administrator's Guide, Volume I.

About the storage lifecycle policies required for Auto Image Replication

To replicate images from one NetBackup domain to another NetBackup domain requires two storage lifecycle policies. The following table describes the policies and their requirements:

<table>
<thead>
<tr>
<th>Domain</th>
<th>Storage lifecycle policy requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain 1 (Source domain)</td>
<td>The Auto Image Replication SLP in the source domain must meet the following criteria:</td>
</tr>
<tr>
<td></td>
<td>■ The first operation must be a <strong>Backup</strong> operation to an OpenStorage appliance. Indicate the exact storage unit from the drop-down list. Do not select <strong>Any Available</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The target domain must contain the same type of storage to import the image.</td>
</tr>
<tr>
<td></td>
<td>■ At least one operation must be a <strong>Replication</strong> operation to the same type of OpenStorage appliance as the source appliance in another NetBackup domain. You can configure multiple <strong>Replication</strong> operations in an Auto Image Replication SLP. The <strong>Replication</strong> operation settings determine whether the backup is replicated to all replication targets in all master server domains or only to specific replication targets.</td>
</tr>
<tr>
<td></td>
<td>■ The SLP must be of the same data classification as the <strong>Import</strong> SLP in Domain 2.</td>
</tr>
</tbody>
</table>
Table 5-10  SLP requirements for Auto Image Replication (continued)

<table>
<thead>
<tr>
<th>Domain</th>
<th>Storage lifecycle policy requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain 2</td>
<td>If replicating to all targets in all domains, in each domain NetBackup automatically creates an <strong>Import</strong> SLP that meets all the necessary criteria.</td>
</tr>
<tr>
<td>(Target</td>
<td>Note: If replicating to specific targets, you must create the <strong>Import</strong> SLP before creating the Auto</td>
</tr>
<tr>
<td>domain)</td>
<td>Image Replication SLP in the originating domain.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Import</strong> SLP must meet the following criteria:</td>
</tr>
<tr>
<td></td>
<td>■ The first operation in the SLP must be an <strong>Import</strong> operation. NetBackup must support the</td>
</tr>
<tr>
<td></td>
<td><strong>Destination storage</strong> as a target for replication from the source storage. Indicate the exact</td>
</tr>
<tr>
<td></td>
<td>storage unit from the drop-down list. Do not select <strong>Any Available</strong>.</td>
</tr>
<tr>
<td></td>
<td>■ The SLP must contain at least one operation that has the <strong>Target retention</strong> specified.</td>
</tr>
<tr>
<td></td>
<td>■ The SLP must be of the same data classification as the SLP in Domain 1. Matching the data</td>
</tr>
<tr>
<td></td>
<td>classification keeps a consistent meaning to the classification and facilitates global reporting</td>
</tr>
<tr>
<td></td>
<td>by data classification.</td>
</tr>
<tr>
<td></td>
<td>See the following topic for more information about <strong>Replication</strong> operation configuration:</td>
</tr>
</tbody>
</table>

**Figure 5-3** shows how the SLP in the target domain is set up to replicate the images from the originating master server domain.
Figure 5-3  Storage lifecycle policy pair required for Auto Image Replication

SLP on master server in the source domain

Replication operation indicates a target master

Import operation imports copies

SLP that imports the copies to the target domain

**Note:** Restart `nbtserv` after you make changes to the underlying storage for any operation in an SLP.

### Creating a storage lifecycle policy

A storage lifecycle policy (SLP) is a storage plan for a set of backups. The operations in an SLP are the backup instructions for the data. Use the following procedure to create an SLP that contains multiple storage operations.
To add a storage operation to a storage lifecycle policy

1. In the NetBackup Administration Console, select NetBackup Management > Storage > Storage Lifecycle Policies.

2. Click Actions > New > New Storage Lifecycle Policy (Windows) or Actions > New > Storage Lifecycle Policy (UNIX).

3. In the New Storage Lifecycle Policy dialog box, enter a Storage lifecycle policy name.
4 Add one or more operations to the SLP. The operations are the instructions for the SLP to follow and apply to the data that is specified in the backup policy.

If this is the first operation added to the SLP, click **Add**.

If this is not the first operation in the SLP, add an operation that is either hierarchical or non-hierarchical:

To create a hierarchical operation, select an operation to become the source of the next operation. Click **Add**. The new operation is a child of the selected operation. The child is indented under the parent operation.

To create a non-hierarchical operation, do not select an operation. A non-hierarchical operation means that the operation does not have a parent and child relationship with another operation. The new operation is not indented.

5 In the **Properties** tab of the **New Storage Operation** dialog box, select an **Operation** type. If you're creating a child operation, the SLP displays only those operations that are valid based on the parent operation that you've selected.

The name of the operation reflects its purpose in the SLP:

- **Backup**
- **Duplication**
- **Import**
- **Replication**
  
  See “About NetBackup Auto Image Replication” on page 69.

6 Configure the properties for the operation.
7 The **Window** tab displays for the following operation types: **Backup From Snapshot**, **Duplication**, **Import**, **Index From Snapshot**, and **Replication**. If you'd like to control when the secondary operation runs, create a window for the operation.

8 Click the **Advanced** button in the **Properties** tab to display options about how the window should behave if the window closes and a secondary operation is not yet complete.

9 Click **OK** to create the operation.

10 Add additional operations to the SLP as needed. (See step 4.)

11 Change the hierarchy of the operations in the SLP if necessary.

12 Click **OK** to create the SLP. NetBackup validates the SLP when it is first created and whenever it is changed.

13 Configure a backup policy and select a storage lifecycle policy as the **Policy storage**.

   See “Creating a backup policy” on page 87.

---

**Storage Lifecycle Policy dialog box settings**

The **New Storage Lifecycle Policy** dialog box and the **Change Storage Lifecycle Policy** dialog box contain the following settings.

**Figure 5-4** Storage Lifecycle Policy tab
### Table 5-11: Storage Lifecycle Policy tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Storage lifecycle policy name</strong></td>
<td>The <strong>Storage lifecycle policy name</strong> describes the SLP. The name cannot be modified after the SLP is created.</td>
</tr>
</tbody>
</table>
| **Data classification**       | The **Data classification** defines the level or classification of data that the SLP is allowed to process. The drop-down menu contains all of the defined classifications as well as the **Any** classification, which is unique to SLPs.  

The **Any** selection indicates to the SLP that it should preserve all images that are submitted, regardless of their data classification. It is available for SLP configuration only and is not available to configure a backup policy.  

In an Auto Image Replication configuration where the master server domains run different versions of NetBackup, see the following topic for special considerations:  

See “About the storage lifecycle policies required for Auto Image Replication” on page 80.  

The **Data classification** is an optional setting.  

One data classification can be assigned to each SLP and applies to all operations in the SLP.  

If a data classification is selected (other than **Any**), the SLP stores only those images from the policies that are set up for that data classification. If no data classification is indicated, the SLP accepts images of any classification or no classification.  

The **Data classification** setting allows the NetBackup administrator to classify data based on relative importance. A classification represents a set of backup requirements. When data must meet different backup requirements, consider assigning different classifications.  

For example, email backup data can be assigned to the silver data classification and financial data backup may be assigned to the platinum classification.  

A backup policy associates backup data with a data classification. Policy data can be stored only in an SLP with the same data classification.  

Once data is backed up in an SLP, the data is managed according to the SLP configuration. The SLP defines what happens to the data from the initial backup until the last copy of the image has expired.  

| Priority for secondary operations | The **Priority for secondary operations** option is the priority that jobs from secondary operations have in relationship to all other jobs. The priority applies to the jobs that result from all operations except for **Backup** and **Snapshot** operations. Range: 0 (default) to 99999 (highest priority).  

For example, you may want to set the **Priority for secondary operations** for a policy with a gold data classification higher than for a policy with a silver data classification.  

The priority of the backup job is set in the backup policy on the **Attributes** tab.  

---
### Table 5-11 Storage Lifecycle Policy tab (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operations</strong></td>
<td>Use the <strong>Add</strong>, <strong>Change</strong>, and <strong>Remove</strong> buttons to create a list of operations in the SLP. An SLP must contain one or more operations. Multiple operations imply that multiple copies are created. The list also contains the columns that display information about each operation. Not all columns display by default. For column descriptions, see the following topic:</td>
</tr>
<tr>
<td><strong>Arrows</strong></td>
<td>Use the arrows to indicate the indentation (or hierarchy) of the source for each copy. One copy can be the source for many other copies.</td>
</tr>
</tbody>
</table>
| **Active and Postponed** | The **Active** and **Postponed** options appear under **State of Secondary Operation Processing** and refer to the processing of all duplication operations in the SLP.  
**Note:** The **Active** and **Postponed** options apply to duplication operations that create tar-formatted images. For example, those created with ```bpduplicate```. The **Active** and **Postponed** options do not affect the images that are duplicated as a result of OpenStorage optimized duplication, NDMP, or if one or more destination storage units are specified as part of a storage unit group.  
- Enable **Active** to let secondary operations continue as soon as possible. When changed from **Postponed** to **Active**, NetBackup continues to process the images, picking up where it left off when secondary operations were made inactive.  
- Enable **Postponed** to postpone the secondary operations for the entire SLP. **Postponed** does not postpone the creation of duplication jobs, it postpones the creation of images instead. The duplication jobs continue to be created, but they are not run until secondary operations are active again.  
  All secondary operations in the SLP are inactive indefinitely unless the administrator selects **Active** or until the **Until** option is selected and an activation date is indicated. |
| **Validate Across Backup Policies button** | Click this button to see how changes to this SLP can affect the policies that are associated with this SLP. The button generates a report that displays on the **Validation Report** tab.  
This button performs the same validation as the ```-conflict``` option performs when used with the ```nbstl``` command. |

---

## Creating a backup policy

The easiest method to set up a backup policy is to use the **Policy Configuration Wizard**. This wizard guides you through the setup process by automatically choosing the best values for most configurations.
Not all policy configuration options are presented through the wizard. For example, calendar-based scheduling and the **Data Classification** setting. After the policy is created, modify the policy in the **Policies** utility to configure the options that are not part of the wizard.

**Note:** Do not use the Policy Configuration Wizard to configure policies for Replication Director.

**Using the Policy Configuration Wizard to create a backup policy**

Use the following procedure to create a backup policy with the Policy Configuration Wizard.

**To create a backup policy with the Policy Configuration Wizard**

1. In the **NetBackup Administration Console**, in the left pane, click **NetBackup Management**.
2. In the right pane, click **Create a Policy** to begin the **Policy Configuration Wizard**.
3. Select **File systems, databases, applications**.
4. Click **Next** to start the wizard and follow the prompts.

Click **Help** on any wizard panel for assistance while running the wizard.

**Creating a backup policy without using the Policy Configuration Wizard**

Use the following procedure to create a backup policy in the **NetBackup Administration Console** without using the Policy Configuration Wizard.

**To create a policy without the Policy Configuration Wizard**

1. In the **NetBackup Administration Console**, in the left pane, expand **NetBackup Management > Policies**.
2. On the **Actions** menu, click **New > Policy**.
3. Type a unique name for the new policy in the **Add a New Policy** dialog box.
4. If necessary, clear the **Use Policy Configuration Wizard** check box.
5. Click **OK**.
6. Configure the attributes, the schedules, the clients, and the backup selections for the new policy.
Adding OpenStorage functionality to an existing environment

Your OpenStorage vendor may update their plug-in to expose more functionality on their disk appliance. For example, the vendor may update their plug-in to support optimized synthetic backups.

If the vendor provides an updated plug-in, you must complete the following procedures to integrate the new functionality into NetBackup.

Table 5-12  Overview of how to add OpenStorage functionality

<table>
<thead>
<tr>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the updated plug-in</td>
<td>See “Installing the disk appliance plug-in” on page 25.</td>
</tr>
<tr>
<td>Update the storage server</td>
<td>You must update the storage server so NetBackup can use the new functionality.</td>
</tr>
<tr>
<td></td>
<td>See “Updating an OpenStorage storage server to reflect plug-in updates” on page 93.</td>
</tr>
<tr>
<td>Update existing disk pools</td>
<td>You also must update existing disk pools so they recognize the new functionality.</td>
</tr>
<tr>
<td></td>
<td>See “Updating an OpenStorage disk pool to reflect plug-in updates” on page 110.</td>
</tr>
<tr>
<td></td>
<td>Any disk pools that you create after you update the vendor plug-in and storage server inherit the new functionality.</td>
</tr>
</tbody>
</table>
Managing OpenStorage

This chapter includes the following topics:

- Managing OpenStorage storage servers
- Managing OpenStorage server credentials
- Managing OpenStorage data movers
- Managing OpenStorage disk pools
- Monitoring OpenStorage storage capacity and usage
- Viewing OpenStorage disk reports
- Reporting on Auto Image Replication jobs
- About catalog backups to OpenStorage devices
- About restoring from OpenStorage backup copies
- About restoring from a backup at a target master domain

Managing OpenStorage storage servers

After you configure OpenStorage, you can perform various tasks to manage storage servers.

See “Viewing OpenStorage storage servers” on page 91.
See “Determining OpenStorage storage server state” on page 91.
See “Changing OpenStorage storage server properties” on page 91.
See “Setting OpenStorage storage server attributes” on page 92.
See “Removing OpenStorage storage server attributes” on page 93.
Viewing OpenStorage storage servers

Use the NetBackup Administration Console to view a list of storage servers already configured.

**To view OpenStorage storage servers**

- In the NetBackup Administration Console, in the left pane, expand Media and Device Management > Credentials > Storage Server.

  The right All Storage Servers pane shows all configured storage servers. OpenStorage storage servers show the vendor string that identifies the storage type in the **Server Type** column.

Determining OpenStorage storage server state

Use the NetBackup nbdevquery command to determine the state of an OpenStorage storage server.

**To determine OpenStorage storage server status**

- Run the following command:

  **UNIX:**
  
  ```
  /usr/openv/netbackup/bin/admincmd/nbdevquery-liststs -stype server_type -storage_server server_name -U
  ```

  **Windows:**
  
  ```
  install_path\NetBackup\bin\admincmd\nbdevquery -liststs -stype server_type -storage_server server_name -U
  ```

  For the **server_type**, the storage vendor provides the string that identifies the server type.

  The **State** field of the command output shows either UP or DOWN.

Changing OpenStorage storage server properties

You can change the OpenStorage storage server properties. The storage vendor exposes the properties that you can change.

See “About OpenStorage storage servers for backups” on page 12.
To change deduplication storage server properties

1. In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Server
2. Select the storage server.
3. On the Edit menu, select Change.
4. In the Change Storage Server dialog box, select the Properties tab.
5. To change a value, select it in the Value column and then change the value.
6. When finished changing values, click OK.
7. Click OK.

Setting OpenStorage storage server attributes

You may have to set attributes on your storage server. Usually, you set attributes to add functionality.

If you set attributes on the storage server, you also must set the same attributes on the existing disk pools. Any disk pools that you create after you set attributes on the storage server inherit the new functionality.

See “Setting OpenStorage disk pool attributes” on page 106.

See “About spanning volumes in OpenStorage disk pools” on page 16.

To set an OpenStorage storage server attribute

- Run the following command on the NetBackup master server or on a storage server:

  UNIX/Linux: /usr/openv/netbackup/bin/admincmd/nbdevconfig-changests -storage_server hostname -stype server_type -setattribute attribute

  Windows: install_path\NetBackup\bin\admincmd\nbdevconfig-changests -storage_server hostname -stype server_type -setattribute attribute

The following are the command arguments that are required and their descriptions:

hostname: The name of the disk appliance host.
server_type: The OpenStorage vendor provides the string that identifies their storage type.
attribute: The name of the attribute that you want to set.
Removing OpenStorage storage server attributes

You may have to remove attributes from your storage server. Usually, you remove attributes to change or remove functionality.

See “Setting OpenStorage storage server attributes” on page 92.

If you remove attributes on the storage server, you also must remove the same attributes on the existing disk pools. Any disk pools that you create after you update the storage server inherit the storage server functionality.

See “Removing OpenStorage disk pool attributes” on page 107.

To remove an OpenStorage storage server attribute

- Run the following command on the NetBackup master server or on a storage server:

  UNIX/Linux: `/usr/openv/netbackup/bin/admincmd/nbdevconfig-changests
  -storage_server hostname -stype server_type -clearattribute
  attribute`

  Windows: `install_path\NetBackup\bin\admincmd\nbdevconfig-changests
  -storage_server hostname -stype server_type -clearattribute
  attribute`

  The following are the command arguments that are required and their descriptions:

  - `hostname` — The name of the disk appliance host.
  - `server_type` — The OpenStorage vendor provides the string that identifies their storage type.
  - `attribute` — The name of the attribute that you want to clear.

Updating an OpenStorage storage server to reflect plug-in updates

If an OpenStorage partner updates their plug-in, update the NetBackup storage server to reflect the new functionality of the plug-in.

If the OpenStorage plug-in is updated on the storage server, use the following procedure to update the NetBackup storage server configuration to reflect this:
To update the NetBackup OpenStorage storage server from the NetBackup Administration Console

1. In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Servers.

2. In the right pane, right-click the storage server.

3. Select Update Storage Server Details.

4. Update the existing disk pools so that each can use the new functionality. Any disk pools that were created after the storage server is updated inherit the new functionality.

   See “Updating an OpenStorage disk pool to reflect plug-in updates” on page 110.

To update the NetBackup OpenStorage storage server configuration from the command line

Run the following command on the master server or on one of the media servers:

On Windows:

```
install_path\NetBackup\bin\admincmd\nbdevconfig -updatests
-storage_server storage_server -stype server_type -media_server media_server
```

On UNIX:

```
/usr/openv/netbackup/bin/admincmd/nbdevconfig -updatests
-storage_server storage_server -stype server_type -media_server media_server
```

See the following descriptions of the options that require arguments:

- `-storage_server` *storage_server*  
  The name of the disk appliance.

- `-stype` *server_type*  
  The storage vendor provides the string that identifies the server type.

- `-media_server` *media_server*  
  A NetBackup media server that connects to the storage server. The media server queries the storage server for its capabilities. The vendor plug-in must be installed on the media server. If the plug-in resides on more than one media server, you can specify any one of them.
Deleting an OpenStorage storage server

If you delete a storage server, NetBackup removes it from your configuration.

**Warning:** Do not delete a storage server if the storage that it manages contains unexpired NetBackup images.

**To delete an OpenStorage storage server**

1. If the storage server currently manages volumes, perform the following tasks:
   - Expire the images on the volumes.
   
   **Warning:** If unexpired images are deleted, data loss may occur.

   - Delete the storage units that comprise the disk pools.
   - Delete the disk pools.

2. In the **NetBackup Administration Console**, in the left pane, expand **Media and Device Management > Credentials > Storage Servers**

3. Select the storage server that you want to delete.

4. On the **Edit** menu, select **Delete**.

5. Click **Yes** in the confirmation dialog box.

6. On the NetBackup master server, use the following command to delete the storage server from the NetBackup EMM database:

   **Linux:**
   ```
   /usr/openv/netbackup/bin/admincmd/nbemmcmd -deletehost -machinename storage_server_name -machinetype ndmp
   ```

   **Windows:**
   ```
   \install_path\NetBackup\bin\admincmd\nbemmcmd -deletehost -machinename storage_server_name -machinetype ndmp
   ```

Managing OpenStorage server credentials

You can perform various tasks to manage existing credentials in NetBackup.

See “Determining if OpenStorage server credentials exist” on page 96.

See “Adding OpenStorage server credentials” on page 96.

See “Changing OpenStorage server credentials” on page 96.

See “Deleting the OpenStorage server credentials of a data mover” on page 97.
Determining if OpenStorage server credentials exist

You can determine which media servers have credentials configured for the storage server.

To determine if the storage server credentials are configured already

1. In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Server.
2. Select the storage server, then select Edit > Change.
3. Select the Media Servers tab.

The media servers for which credentials are configured are identified in the Media Servers Status column.

Adding OpenStorage server credentials

You can add a media server as a data mover to your OpenStorage configuration. If you do, you must add the storage server credentials to that media server.

See “Adding an OpenStorage data mover” on page 98.

To add OpenStorage server credentials

1. In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Servers.
2. Select the storage server, then select Edit > Change.
3. Select the Media Servers tab.
4. Select the server you want to add. Also make sure that any servers already credentialed are selected.
5. Enter the credentials.
6. Click Set and then click OK.

Changing OpenStorage server credentials

You can change the credentials that the media servers that function as data movers use. The credentials are for the storage server.

See “About OpenStorage server credentials” on page 13.

To change OpenStorage server credentials

1. In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Server.
2. Select the storage server, then select Edit > Change.
3 Select the Media Servers tab.
4 Select the media servers that function as data movers.
5 Change the credentials.
6 Click Set and then click OK.

Deleting the OpenStorage server credentials of a data mover

If you remove a media server as a data mover, you must delete the storage server credentials of the media server.

If the host failed and is unavailable, you can use the `tpconfig` device configuration utility in menu mode to delete the credentials. However, you must run the `tpconfig` utility on a UNIX or Linux NetBackup server.

For procedures, see the *NetBackup Administrator’s Guide, Volume II*.

To delete OpenStorage server credentials of a data mover

1 In the NetBackup Administration Console, expand Media and Device Management > Credentials > Storage Server.
2 Select the storage server, then select Edit > Change.
3 Select the Media Servers tab.
4 Select the media server for which you want to delete the credentials.
5 Click Remove and then click OK.

Managing OpenStorage data movers

In OpenStorage, NetBackup media servers function as the data movers. A data mover is an entity that moves data between the primary storage (the NetBackup client) and the storage server.

For an existing OpenStorage environment in NetBackup, you can do the following:

- Add a media server as a data mover.
  See “Adding an OpenStorage data mover” on page 98.
  To add an OpenStorage data mover, see the procedure later in this section.

- Retire a media server as a data mover.
  See “Retiring an OpenStorage data mover” on page 98.

See “About OpenStorage data movers for backups” on page 13.
Adding an OpenStorage data mover

Use the following process to add an OpenStorage data mover.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Install and configure the NetBackup media server software.</td>
<td>See the NetBackup Installation Guide for UNIX and Windows.</td>
</tr>
<tr>
<td>Step 2</td>
<td>For disk appliance storage, install the OpenStorage vendor software plug-in on the media server</td>
<td>See &quot;Installing the disk appliance plug-in&quot; on page 25.</td>
</tr>
<tr>
<td>Step 3</td>
<td>For disk appliance storage, connect the NetBackup media server to the OpenStorage appliance.</td>
<td>Beyond the scope of the NetBackup documentation.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Add the storage server logon credentials for the media server.</td>
<td>See &quot;Adding OpenStorage server credentials&quot; on page 96.</td>
</tr>
<tr>
<td>Step 5</td>
<td>For every storage unit that points to a disk pool of that storage server, verify that the new media server appears. The storage unit dialog box includes a media servers list. For every storage unit that is configured to use any available media server, the new data mover is allowed access to the storage server automatically.</td>
<td>In the NetBackup Administration Console, in the left pane, select NetBackup Management &gt; Storage &gt; Storage Units.</td>
</tr>
<tr>
<td>Step 6</td>
<td>For every storage unit that specifies Use one of the following media servers, update the storage unit so it uses the correct data movers. This step is not required if the storage unit is configured to use any available media server.</td>
<td>In the NetBackup Administration Console, in the left pane, select NetBackup Management &gt; Storage &gt; Storage Units.</td>
</tr>
</tbody>
</table>

Retiring an OpenStorage data mover

Use the following process to retire an OpenStorage data mover.
### Table 6-2  Process to retire an OpenStorage data mover

<table>
<thead>
<tr>
<th>What</th>
<th>Where</th>
</tr>
</thead>
<tbody>
<tr>
<td>For every NetBackup storage unit that specifies that data mover (that is, media server), clear the checkbox that specifies the media server. This step is not required if the storage unit is configured to use any available media server.</td>
<td>See the NetBackup Installation Guide for UNIX and Windows.</td>
</tr>
<tr>
<td>On the media server to be retired, delete the credentials for the storage server.</td>
<td>See “Deleting the OpenStorage server credentials of a data mover” on page 97.</td>
</tr>
</tbody>
</table>

### Managing OpenStorage disk pools

After you configure OpenStorage, you can perform various tasks to manage your OpenStorage disk pools.

See “Viewing OpenStorage disk pools” on page 99.
See “Determining OpenStorage disk pool state” on page 100.
See “Changing OpenStorage disk pool state” on page 100.
See “Determining OpenStorage disk volume state” on page 100.
See “Changing OpenStorage disk volume state” on page 101.
See “Changing OpenStorage disk pool properties” on page 102.
See “Setting OpenStorage disk pool attributes” on page 106.
See “Removing OpenStorage disk pool attributes” on page 107.
See “Adding volumes to an OpenStorage disk pool” on page 108.
See “Merging OpenStorage disk pools” on page 108.
See “Removing a volume from an OpenStorage disk pool” on page 109.
See “Updating an OpenStorage disk pool to reflect plug-in updates” on page 110.
See “Deleting an OpenStorage disk pool” on page 111.

### Viewing OpenStorage disk pools

Use the NetBackup Administration Console to view configured disk pools.
To view disk pools
  ✷ In the NetBackup Administration Console, in the left pane, expand Media and Device Management > Devices > Disk Pools.

Determining OpenStorage disk pool state
Disk pool state is UP or DOWN.

To determine OpenStorage disk pool state
1 In the NetBackup Administration Console, in the left pane, select Media and Device Management > Device Monitor.
2 At the bottom of the right pane, select the Disk Pools tab.
3 Select the disk pool.
4 The state is displayed in the Status column.

Changing OpenStorage disk pool state
You can change the state of a NetBackup disk pool. Pool states are UP or DOWN.

To change the state to DOWN, the disk pool must not be busy. If backup jobs are assigned to the disk pool, the state change fails. Cancel the backup jobs or wait until the jobs complete.

To change OpenStorage disk pool state
1 In the NetBackup Administration Console, in the left pane, select Media and Device Management > Device Monitor.
2 Select the Disk Pools tab.
3 Select the disk pool.
4 Select either Actions > Up or Actions > Down.

Determining OpenStorage disk volume state
Use the NetBackup nbdevquery command to determine the state of volumes in OpenStorage disk pools.
To determine OpenStorage disk volume state

- Display the state of the volumes in a disk pool by using the following command:

  UNIX: `/usr/openv/netbackup/bin/admincmd/nbdevquery -listdv -U -stype server_type -dp disk_pool_name`

  Windows: `install_path\NetBackup\bin\admincmd\nbdevquery -listdv -U -stype server_type -dp disk_pool_name`

  The storage vendor provides the string that identifies the `server_type`.

  The command displays all of the volumes in the disk pool. The `state` is either `UP` or `DOWN`.

  To display the disk volumes in all OpenStorage disk pools on that vendor's storage, omit the `-dp` option.

Changing OpenStorage disk volume state

Use the NetBackup `nbdevconfig` command to change disk volume state. The state is `UP` or `DOWN`.

To change the state to `DOWN`, the disk pool in which the volume resides must not be busy. If backup jobs are assigned to the disk pool, the state change fails. Cancel the backup jobs or wait until the jobs complete.

NetBackup jobs still read from and write to a disk pool that has a downed volume, but the downed volume is unavailable.

To change OpenStorage disk volume state

1. Determine the name of the disk volume.
   - See "Determining OpenStorage disk volume state" on page 100.

2. Change the disk volume state using the following command syntax:

   UNIX: `/usr/openv/netbackup/bin/admincmd/nbdevconfig -changestate -stype server_type -dp disk_pool_name -dv vol_name -state state`

   Windows: `install_path\NetBackup\bin\admincmd\nbdevconfig -changestate -stype server_type -dp disk_pool_name -dv vol_name -state state`

   For the `server_type`, the storage vendor provides the string that identifies the server type.

   For the `-state`, specify either `UP` or `DOWN`.
Changing OpenStorage disk pool properties

You can change the properties of a disk pool and manage the topology of existing volumes that have replication properties. Information about how NetBackup processes topology changes is in a different topic.

See “How to resolve volume changes for Auto Image Replication” on page 103.

Another method exists to add volumes to a disk pool.

See “Adding volumes to an OpenStorage disk pool” on page 108.

To change OpenStorage disk pool properties

1. In the NetBackup Administration Console, in the left pane, expand Media and Device Management > Devices > Disk Pools.

2. In the right pane, select the disk pool you want to change.

3. Click Edit > Change.

![Change Disk Pool dialog box](image)
4 To query the storage server for disk volume changes, click **Refresh** in the **Change Disk Pool** dialog box.

If NetBackup discovers changes to the replication topology, your actions depend on the changes discovered.

See "How to resolve volume changes for Auto Image Replication" on page 103.

5 Change the other properties as necessary.

See “OpenStorage disk pool properties” on page 51.

6 Click **OK**.

### How to resolve volume changes for Auto Image Replication

When you open the **Change Disk Pool** dialog box, NetBackup loads the disk pool properties from the catalog. NetBackup queries the storage server for changes when you either click the **Refresh** button in the **Change Disk Pool** dialog box or when you configure a new disk pool for the storage server.

Veritas recommends that you take the following actions when the volume topology changes:

- Discuss the changes with the storage administrator. You need to understand the changes so you can change your disk pools (if required) so that NetBackup can continue to use them.

- If the changes were not planned for NetBackup, ask your storage administrator to revert the changes so that NetBackup functions correctly again.

NetBackup can process changes to the following volume properties:

- Replication Source
- Replication Target
- None

If these volume properties change, NetBackup can update the disk pool to match the changes. NetBackup can continue to use the disk pool, although the disk pool may no longer match the storage unit or storage lifecycle purpose.

The following table describes the possible outcomes and how to resolve them.

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No changes are discovered.</td>
<td>No changes are required.</td>
</tr>
<tr>
<td>Outcome</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>NetBackup discovers the new volumes that you can add to the disk pool.</td>
<td>The new volumes appear in the <strong>Change Disk Pool</strong> dialog box. Text in the dialog box changes to indicate that you can add the new volumes to the disk pool.</td>
</tr>
</tbody>
</table>
| The replication properties of all of the volumes changed, but they are still consistent. | A **Disk Pool Configuration Alert** pop-up box notifies you that the properties of all of the volumes in the disk pool changed, but they are all the same (homogeneous). You must click **OK** in the alert box, after which the disk pool properties in the **Change Disk Pool** dialog box are updated to match the new volume properties. If new volumes are available that match the new properties, NetBackup displays those volumes in the **Change Disk Pool** dialog box. You can add those new volumes to the disk pool. In the **Change Disk Pool** dialog box, select one of the following two choices:  
  - **OK**. To accept the disk pool changes, click **OK** in the **Change Disk Pool** dialog box. NetBackup saves the new properties of the disk pool. NetBackup can use the disk pool, but it may no longer match the intended purpose of the storage unit or storage lifecycle policy. Change the storage lifecycle policy definitions to ensure that the replication operations use the correct source and target disk pools, storage units, and storage unit groups. Alternatively, work with your storage administrator to change the volume properties back to their original values.  
  - **Cancel**. To discard the changes, click **Cancel** in the **Change Disk Pool** dialog box. NetBackup does not save the new disk pool properties. NetBackup can use the disk pool, but it may no longer match the intended use of the storage unit or storage lifecycle policy. |
### Table 6-3 Refresh outcomes (continued)

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
</table>
| The replication properties of the volumes changed, and they are now inconsistent. | **A Disk Pool Configuration Error** pop-up box notifies you that the replication properties of some of the volumes in the disk pool changed. The properties of the volumes in the disk pool are not homogeneous.  

![Disk Pool Configuration Error](image)  

You must click **OK** in the alert box.  

In the **Change Disk Pool** dialog box, the properties of the disk pool are unchanged, and you cannot select them (that is, they are dimmed). However, the properties of the individual volumes are updated.  

Because the volume properties are not homogeneous, NetBackup cannot use the disk pool until the storage configuration is fixed.  

NetBackup does not display new volumes (if available) because the volumes already in the disk pool are not homogeneous.  

To determine what has changed, compare the disk pool properties to the volume properties.  

See “Viewing the replication topology for Auto Image Replication” on page 76.  

Work with your storage administrator to understand the changes and why they were made. The replication relationships may or may not have to be re-established. If the relationship was removed in error, re-establishing the relationships seem justified. If you are retiring or replacing the target replication device, you probably do not want to re-establish the relationships.  

The disk pool remains unusable until the properties of the volumes in the disk pool are homogenous.  

In the **Change Disk Pool** dialog box, click **OK** or **Cancel** to exit the **Change Disk Pool** dialog box. |
Table 6-3  Refresh outcomes (continued)

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetBackup cannot find a volume or volumes that were in the disk pool.</td>
<td>A <strong>Disk Pool Configuration Alert</strong> pop-up box notifies you that an existing volume or volumes was deleted from the storage device:</td>
</tr>
<tr>
<td></td>
<td><strong>Disk Pool Configuration Alert</strong></td>
</tr>
<tr>
<td></td>
<td>An existing volume in this disk pool cannot be found on the storage device and is no longer available to NetBackup. The volume might be offline or deleted. If deleted, any data on that volume is lost.</td>
</tr>
<tr>
<td></td>
<td>Volume(s) deleted: disk02</td>
</tr>
<tr>
<td></td>
<td>Refer to documentation for information on how to resolve this issue.</td>
</tr>
</tbody>
</table>

NetBackup can use the disk pool, but data may be lost.

To protect against accidental data loss, NetBackup does not allow volumes to be deleted from a disk pool.

To continue to use the disk pool, do the following:

- Use the `bpimmedia` command or the Images on Disk report to display the images on the specific volume.
- Expire the images on the volume.
- Use the `nbdevconfig` command to set the volume state to DOWN so NetBackup does not try to use it.

---

**Setting OpenStorage disk pool attributes**

You may have to set attributes on your disk pools. Usually, you set attributes to add functionality.

If you set attributes on the storage server, you also must set the same attributes on the existing disk pools. Any disk pools that you create after you set attributes on the storage server inherit the new functionality.

See “**Setting OpenStorage storage server attributes**” on page 92.

See “**About spanning volumes in OpenStorage disk pools**” on page 16.
To set an OpenStorage disk pool attribute

- Run the following command on the NetBackup master server or on a storage server:

  **UNIX/Linux:** /usr/openv/netbackup/bin/admincmd/nbdevconfig -changedp -dp dp_name -stype server_type -setattribute attribute

  **Windows:** install_path\NetBackup\bin\admincmd\nbdevconfig -changedp -dp dp_name -stype server_type -setattribute attribute

  The following are the command arguments that are required and their descriptions:

  - `dp_name`: The name of the disk pool.
  - `server_type`: The OpenStorage vendor provides the string that identifies their storage type.
  - `attribute`: The name of the attribute that you want to set.

Removing OpenStorage disk pool attributes

You may have to remove attributes on your disk pools. Usually, you remove attributes to remove functionality.

See “Setting OpenStorage disk pool attributes” on page 106.

To remove an OpenStorage disk pool attribute

- Run the following command on the NetBackup master server or on a storage server:

  **UNIX/Linux:** /usr/openv/netbackup/bin/admincmd/nbdevconfig -changedp -dp dp_name -stype server_type -clearattribute attribute

  **Windows:** install_path\NetBackup\bin\admincmd\nbdevconfig -changedp -dp dp_name -stype server_type -clearattribute attribute

  The following are the command arguments that are required and their descriptions:

  - `dp_name`: The name of the disk pool.
  - `server_type`: The OpenStorage vendor provides the string that identifies their storage type.
  - `attribute`: The name of the attribute that you want to clear.
Adding volumes to an OpenStorage disk pool

If you add disk volumes to the storage appliance, NetBackup does not add those volumes to an OpenStorage disk pool automatically. To use the additional disk volumes in an existing disk pool, you must add those volumes to the disk pool.

(By default, NetBackup automatically increases disk pool capacity if the capacity of the underlying disk volumes increases. Similarly, NetBackup decreases the capacity of a disk pool if the underlying disk volume capacity decreases.)

The NetBackup storage units that use the disk pool automatically use the additional storage capacity. You do not have to change the storage units.

You also can add volumes by using the Change Disk Pool dialog box.

See “Changing OpenStorage disk pool properties” on page 102.

Table 6-4 Add volumes process for OpenStorage disk pool

<table>
<thead>
<tr>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure a disk pool from the new disk volumes on the storage server.</td>
<td>See “Configuring an OpenStorage disk pool for backups” on page 44.</td>
</tr>
<tr>
<td>Merge the disk pools. When you merge the disk pools, specify the original disk pool as the primary one. NetBackup deletes the secondary disk pool after the merge.</td>
<td>See “Merging OpenStorage disk pools” on page 108.</td>
</tr>
</tbody>
</table>

Merging OpenStorage disk pools

Use the NetBackup `nbdevconfig` command to merge existing disk pools.

NetBackup updates the catalog records to show the correct location of the backup images in those disk pools.

The following are the prerequisites:

- The volumes in the two disk pools must have unique names. OpenStorage requires that vendors use unique names for disk volumes in a disk appliance.
- All volumes must be from the same storage server.
- If the secondary disk pool is referenced by storage units, you must delete those storage units.
To merge OpenStorage disk pools

1 Change the state of each disk pool to DOWN.

See “Changing OpenStorage disk pool state” on page 100.

If backup jobs are assigned to a disk pool, the state change fails. Cancel the backup jobs or wait until the jobs complete.

2 Merge the disk pools. The following is the command syntax. The primary disk pool is the one you want to retain; nbdevconfig deletes the secondary disk pool after the merge.

nbdevconfig -mergedps -stype server_type -primarydp disk_pool_name -secondarydp disk_pool_name

The following is the path to the nbdevconfig command:

- UNIX: /usr/openv/netbackup/bin/admincmd
- Windows: install_path\NetBackup\bin\admincmd

3 Change the state of the primary disk pool to UP.

See “Changing OpenStorage disk pool state” on page 100.

Removing a volume from an OpenStorage disk pool

Use the NetBackup nbdevconfig command to remove a volume from a disk pool. The following are the prerequisites:

- NetBackup image fragments cannot exist on the disk volume.
- NetBackup jobs cannot be active on the disk volume.

By default, NetBackup automatically decreases disk pool capacity if you remove a disk volume.

To remove a volume from an OpenStorage disk pool

1 Change the disk volume state to DOWN.

See “Changing OpenStorage disk volume state” on page 101.

2 Change the disk pool state to DOWN.

See “Changing OpenStorage disk pool state” on page 100.

3 Remove the volume by using the nbdevconfig command. The following is the command syntax:

nbdevconfig -deletedv -stype server_type -dp disk_pool_name -dv vol_name

The following is the path to the nbdevconfig command:
UNIX: /usr/openv/netbackup/bin/admincmd
Windows: install_path\NetBackup\bin\admincmd

For the server_type, the storage vendor provides the string that identifies the server type.

4 Change the disk pool state to UP.
See “Changing OpenStorage disk pool state” on page 100.

Updating an OpenStorage disk pool to reflect plug-in updates

If an OpenStorage partner updates their plug-in, update the existing disk pools to reflect the new functionality of the plug-in after you update the NetBackup storage server.

Any disk pools that are created after the storage server is updated inherit the new functionality.

See “Adding OpenStorage functionality to an existing environment” on page 89.

To update an OpenStorage disk pool to reflect plug-in updates

Run the following command on the master server:

On Windows:

install_path\NetBackup\bin\admincmd\nbdevconfig -changedp -dp disk_pool_name -stype server_type -setattribute attribute

On UNIX:

/usr/openv/netbackup/bin/admincmd/nbdevconfig -changedp -dp disk_pool_name -stype server_type -setattribute attribute

See the following descriptions of the options that require arguments:

- changedp
  disk_pool_name  The name of the disk pool.

- stype server_type  The storage vendor provides the string that identifies the server type.

- setattribute attribute  The attribute is the name of the argument that represents the new functionality.

For example, OptimizedImage specifies that the environment supports the optimized synthetic backup. SpanImages specifies that backup images can span across volumes on the disk appliance.
Deleting an OpenStorage disk pool

If you delete a disk pool, NetBackup removes it from your configuration.

If a disk pool is the storage destination of a storage unit, you must first delete the storage unit.

**Warning:** Do not delete a disk pool that contains unexpired NetBackup images; if you do, data loss may occur.

To delete an OpenStorage disk pool

1. In the NetBackup Administration Console, in the left pane, select Media and Device Management > Devices > Disk Pools.
2. Select a disk pool.
3. Click Edit > Delete.
4. In the Delete Disk Pool dialog box, verify that the disk pool is the one you want to delete and then click OK.

Monitoring OpenStorage storage capacity and usage

To monitor storage capacity and usage, see the following:

- **The NetBackup Administration Console Disk Pools window**
  - The Disk Pools window displays a value that was stored when NetBackup polled the disk pools. The value may not be as current as the value that is displayed in the Storage Server window.
  - To display the window, in the NetBackup Administration Console, in the left pane, select Media and Device Management > Devices > Disk Pools.

- **The NetBackup Disk Pool status report**
  - See “Viewing OpenStorage disk reports” on page 112.

- **NetBackup Administration Console Storage Server window**
  - The storage server view displays real-time values.
  - To display the window, in the NetBackup Administration Console, in the left pane, select Media and Device Management > Credentials > Storage Servers.

The NetBackup OpsCenter also provides information about storage capacity and usage.

See the NetBackup OpsCenter Administrator's Guide:
Viewing OpenStorage disk reports

The NetBackup disk reports include information about the disk pools, disk storage units, disk logs, images that are stored on disk media, and storage capacity.

Table 6-5 describes the disk reports available.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images on Disk</td>
<td>The Images on Disk report generates the image list present on the disk storage units that are connected to the media server. The report is a subset of the Images on Media report; it shows only disk-specific columns. The report provides a summary of the storage unit contents. If a disk becomes bad or if a media server crashes, this report can let you know what data is lost.</td>
</tr>
<tr>
<td>Disk Logs</td>
<td>The Disk Logs report displays the media errors or the informational messages that are recorded in the NetBackup error catalog. The report is a subset of the Media Logs report; it shows only disk-specific columns.</td>
</tr>
<tr>
<td>Disk Storage Unit Status</td>
<td>The Disk Storage Unit Status report displays the state of disk storage units in the current NetBackup configuration. For disk pool capacity, see the disk pools window in Media and Device Management &gt; Devices &gt; Disk Pools. Multiple storage units can point to the same disk pool. When the report query is by storage unit, the report counts the capacity of disk pool storage multiple times.</td>
</tr>
<tr>
<td>Disk Pool Status</td>
<td>The Disk Pool Status report displays the state of disk pool storage units. This report displays only when a license that activates a disk pool feature is installed.</td>
</tr>
</tbody>
</table>

To view disk reports

1. In the NetBackup Administration Console, in the left pane, expand NetBackup Management > Reports > Disk Reports.
2. Select the name of a disk report.
3. In the right pane, select the report settings.
Reporting on Auto Image Replication jobs

The Activity Monitor displays both the Replication job and the Import job in a configuration that replicates to a target master server domain.

Table 6-6 Auto Image Replication jobs in the Activity Monitor

<table>
<thead>
<tr>
<th>Job type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication</td>
<td>The job that replicates a backup image to a target master displays in the Activity Monitor as a Replication job. The Target Master label displays in the Storage Unit column for this type of job. Similar to other Replication jobs, the job that replicates images to a target master can work on multiple backup images in one instance. The detailed status for this job contains a list of the backup IDs that were replicated.</td>
</tr>
<tr>
<td>Import</td>
<td>The job that imports a backup copy into the target master domain displays in the Activity Monitor as an Import job. An Import job can import multiple copies in one instance. The detailed status for an Import job contains a list of processed backup IDs and a list of failed backup IDs. Note that a successful replication does not confirm that the image was imported at the target master. If the data classifications are not the same in both domains, the Import job fails and NetBackup does not attempt to import the image again. Failed Import jobs fail with a status 191 and appear in the Problems report when run on the target master server. The image is expired and deleted during an Image Cleanup job. Note that the originating domain (Domain 1) does not track failed imports.</td>
</tr>
</tbody>
</table>

About catalog backups to OpenStorage devices

Both full catalog recovery and partial catalog recovery is possible from a primary catalog backup copy on disk storage. Therefore, you can write a hot catalog backup to an OpenStorage disk appliance and then recover the catalog from the primary copy. Caveat: the recovery must be in the domain in which the catalog was created.

NetBackup also supports duplication of the catalog by using a Storage Lifecycle Policy. However, limitations exist for recovery from non-primary copies of the catalog backup or from catalog copies in other domains. Several tech notes discuss the limitations and catalog recovery.

http://veritas.com/docs/TECH72098
http://veritas.com/docs/TECH72198
## About restoring from OpenStorage backup copies

By default, NetBackup restores from the primary copy of an image. If you want to restore from an optimized duplication copy or a direct to tape copy of a backup image, you must specify the copy.

See “Restoring from a specific backup copy” in the Backup, Archive, and Restore help.

## About restoring from a backup at a target master domain

While it is possible to restore a client directly by using the images in the target master domain, do so only in a disaster recovery situation. In this discussion, a disaster recovery situation is one in which the originating domain no longer exists and clients must be recovered from the target domain.

### Table 6-7  
**Client restores in disaster recovery scenarios**

<table>
<thead>
<tr>
<th>Disaster recovery scenario</th>
<th>Does client exist?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario 1</td>
<td>Yes</td>
<td>Configure the client in another domain and restore directly to the client.</td>
</tr>
<tr>
<td>Scenario 2</td>
<td>No</td>
<td>Create the client in the recovery domain and restore directly to the client. This is the most likely scenario.</td>
</tr>
<tr>
<td>Scenario 3</td>
<td>No</td>
<td>Perform an alternate client restore in the recovery domain.</td>
</tr>
</tbody>
</table>

The steps to recover the client are the same as any other client recovery. The actual steps depend on the client type, the storage type, and whether the recovery is an alternate client restore.

For restores that use Granular Recovery Technology (GRT), an application instance must exist in the recovery domain. The application instance is required so that NetBackup has something to recover to.
Troubleshooting

This chapter includes the following topics:

- About unified logging
- About legacy logging
- NetBackup OpenStorage log files
- Troubleshooting OpenStorage credentials creation

About unified logging

Unified logging and legacy logging are the two forms of debug logging used in NetBackup. All NetBackup processes use one of these forms of logging. Server processes and client processes use unified logging.

Unified logging creates log file names and messages in a standardized format. These logging files cannot be easily viewed with a text editor. They are in binary format and some of the information is contained in an associated resource file. Only the vxlogview command can assemble and display the log information correctly.

Unlike legacy logging, unified logging does not require that you create logging subdirectories. Log files for originator IDs are written to a subdirectory with the name specified in the log configuration file. All unified logs are written to subdirectories in the following directory:

Windows  

\install_path\NetBackup\logs

UNIX  

/usr/openv/logs

You can access logging controls in the NetBackup Administration Console. In the left pane, expand **NetBackup Management > Host Properties > Master**
Servers or Media Servers. Double-click the server you want to change. In the left pane of the dialog box, click Logging.

You can also manage unified logging by using the following commands:

- **vxlogcfg**: Modifies the unified logging configuration settings. For more information about the `vxlogcfg` command.
- **vxlogmgr**: Manages the log files that the products that support unified logging generate. For more information about the `vxlogmgr` command.
- **vxlogview**: Displays the logs that unified logging generates. See “Examples of using vxlogview to view unified logs” on page 117. For more information about the `vxlogview` command.

These commands are located in the following directory:

- **Windows**: `install_path\NetBackup\bin`
- **UNIX**: `/usr/openv/netbackup/bin`

See the NetBackup Commands Reference Guide for a complete description about these commands.

More information about legacy logging is available. See “About legacy logging” on page 118.

### About using the `vxlogview` command to view unified logs

Use the `vxlogview` command to view the logs that unified logging creates. These logs are stored in the following directory.

- **UNIX**: `/usr/openv/logs`
- **Windows**: `install_path\NetBackup\logs`

Unlike the files that are written in legacy logging, unified logging files cannot be easily viewed with a text editor. The unified logging files are in binary format, and some of the information is contained in an associated resource file. Only the `vxlogview` command can assemble and display the log information correctly.

You can use `vxlogview` to view NetBackup log files as well as PBX log files. To view PBX logs using the `vxlogview` command, do the following:
- Ensure that you are an authorized user. For UNIX and Linux, you must have root privileges. For Windows, you must have administrator privileges.

- To specify the PBX product ID, enter `-p 50936` as a parameter on the `vxlogview` command line.

`vxlogview` searches all the files, which can be a slow process. Refer to the following topic for an example of how to display results faster by restricting the search to the files of a specific process.

### Examples of using vxlogview to view unified logs

The following examples demonstrate how to use the `vxlogview` command to view unified logs.

**Table 7-1** Example uses of the `vxlogview` command

<table>
<thead>
<tr>
<th>Item</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display all the attributes of the log messages</td>
<td><code>vxlogview -p 51216 -d all</code></td>
</tr>
</tbody>
</table>
| Display specific attributes of the log messages | Display the log messages for NetBackup (51216) that show only the date, time, message type, and message text:  
`vxlogview --prodid 51216 --display D,T,m,x` |
| Display the latest log messages | Display the log messages for originator 116 (nbpem) that were issued during the last 20 minutes. Note that you can specify `-o nbpem` instead of `-o 116`:  
`# vxlogview -o nbpem -t 00:20:00` |
| Display the log messages from a specific time period | Display the log messages for `nbpem` that were issued during the specified time period:  
`# vxlogview -o nbpem -b "05/03/15 06:51:48 AM" -e "05/03/15 06:52:48 AM"` |
### Table 7-1

<table>
<thead>
<tr>
<th>Item</th>
<th>Example uses of the <code>vxlogview</code> command (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display results faster</td>
<td>You can use the <code>-i</code> option to specify an originator for a process:</td>
</tr>
<tr>
<td></td>
<td><code># vxlogview -i nbpem</code></td>
</tr>
<tr>
<td></td>
<td>The <code>vxlogview -i</code> option searches only the log files that the specified process (<code>nbpem</code>) creates. By limiting the log files that it has to search, <code>vxlogview</code> returns a result faster. By comparison, the <code>vxlogview -o</code> option searches all unified log files for the messages that the specified process has logged.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you use the <code>-i</code> option with a process that is not a service, <code>vxlogview</code> returns the message &quot;No log files found.&quot; A process that is not a service has no originator ID in the file name. In this case, use the <code>-o</code> option instead of the <code>-i</code> option.</td>
</tr>
<tr>
<td></td>
<td>The <code>-i</code> option displays entries for all OIDs that are part of that process including libraries (137, 156, 309, etc.).</td>
</tr>
<tr>
<td>Search for a job ID</td>
<td>You can search the logs for a particular job ID:</td>
</tr>
<tr>
<td></td>
<td>`# vxlogview -i nbpem</td>
</tr>
<tr>
<td></td>
<td>The <code>jobid=</code> search key should contain no spaces and must be lowercase.</td>
</tr>
<tr>
<td></td>
<td>When searching for a job ID, you can use any <code>vxlogview</code> command option. This example uses the <code>-i</code> option with the name of the process (<code>nbpem</code>). The command returns only the log entries that contain the job ID. It misses related entries for the job that do not explicitly contain the <code>jobid=job_ID</code>.</td>
</tr>
</tbody>
</table>

See the *NetBackup Commands Reference Guide* for a complete description of the `vxlogview` command. The guide is available through the following URL:

[http://www.veritas.com/docs/DOC5332](http://www.veritas.com/docs/DOC5332)

### About legacy logging

Legacy logging and unified logging are the two forms of debug logging used in NetBackup. All NetBackup processes use either unified logging or legacy logging.

See “About unified logging” on page 115.
In legacy debug logging, each process creates log files of debug activity in its own logging directory. The NetBackup legacy debug log directories are located in the following directories:

**Windows**
- `install_path\NetBackup\logs`
- `install_path\Volmgr\debug`

**UNIX**
- `/usr/openv/netbackup/logs`
- `/usr/openv/volmgr/debug`

These top-level directories can contain a directory for each NetBackup process that uses legacy logging. By default, NetBackup creates only a subset of all of the possible log directories. For example, the following directories are created by default on UNIX servers:

- `nbfp`
- `nbliveup`
- `nblogadm`
- `user_ops`

To enable logging for all of the NetBackup processes that use legacy logging, you must create the log file directories that do not already exist, unless you use the Logging Assistant. For more information about the Logging Assistant, see the *NetBackup Administrator's Guide, Volume I*. The guide is available at the following location:

http://www.veritas.com/docs/DOC5332

You can use the following batch files to create all of the debug log directories at once:

- **Windows**: `install_path\NetBackup\Logs\mklogdir.bat`
- **UNIX**: `/usr/openv/netbackup/logs/mklogdir`

See the *NetBackup Commands Reference Guide* for a complete description about the `mklogdir` command. The guide is available at the following location:

http://www.veritas.com/docs/DOC5332

After the directories are created, NetBackup creates log files in the directory that is associated with each process. A debug log file is created when the process begins. Each log file grows to a certain size before the NetBackup process closes it and creates a new log file.
To enable debug logging for the NetBackup Status Collection Daemon (vmscd), create the following directory before you start nbemm.

Windows
install_path\Volmgr\debug\vmscd\

UNIX
/usr/openv/volmgr/debug/vmscd

As an alternative, you can restart vmscd after creating the directory.

Creating NetBackup log file directories for OpenStorage

Before you configure your NetBackup feature, create the directories into which the NetBackup commands write log files. Create the directories on the master server and on each media server that you use for your feature. The log files reside in the following directories:

- UNIX: /usr/openv/netbackup/logs/
- Windows: install_path\NetBackup\logs\n
More information about NetBackup logging is available in the NetBackup Logging Reference Guide, available through the following URL:

http://www.veritas.com/docs/DOC5332

See “NetBackup OpenStorage log files” on page 120.

To create log directories for NetBackup commands

- Depending on the operating system, run one of the following scripts:
  - UNIX: /usr/openv/netbackup/logs/mklogdir
  - Windows: install_path\NetBackup\logs\mklogdir.bat

To create the tpconfig command log directory

- Depending on the operating system, create the debug directory and the tpcommand directory (by default, the debug directory and the tpcommand directory do not exist). The pathnames of the directories are as follows:
  - UNIX: /usr/openv/volmgr/debug/tpcommand
  - Windows: install_path\Veritas\Volmgr\debug\tpcommand

NetBackup OpenStorage log files

You can monitor NetBackup OpenStorage activity and status by viewing the NetBackup log files.
Some NetBackup commands or processes write messages to their own log files. For those commands and processes, the log directories must exist so that the utility can write log messages.

See “Creating NetBackup log file directories for OpenStorage” on page 120.

Other processes use Veritas unified log (VxUL) files. Each process has a corresponding VxUL originator ID. VxUL uses a standardized name and file format for log files. To view VxUL log files, you must use the NetBackup `vxlogview` command.

More information about how to view and manage VxUL log files is available. See the NetBackup Logging Reference Guide:

http://www.veritas.com/docs/DOC5332

The following are the component identifiers for log messages:

- An `sts_` prefix relates to the interaction with the plug-in that writes to and reads from the storage.
  - For OpenStorage, the storage vendor provides the plug-in.
- An `encrypt` prefix relates to interaction with the encryption plug-in.

Most interaction occurs on the NetBackup media servers. Therefore, the log files on the media servers that you use for disk operations are of most interest.

**Warning:** The higher the log level, the greater the affect on NetBackup performance. Use a log level of 5 (the highest) only when directed to do so by a Veritas representative. A log level of 5 is for troubleshooting only.

Specify the NetBackup log levels in the **Logging** host properties on the NetBackup master server. The log levels for some processes specific to certain options are set in configuration files as described in Table 7-2.

**Table 7-2** describes the logs.
# Table 7-2 NetBackup logs

<table>
<thead>
<tr>
<th>Activity</th>
<th>OID</th>
<th>Processes</th>
</tr>
</thead>
</table>
| Backups and restores                          | N/A | Messages appear in the log files for the following processes:  
  - The `bpbrm` backup and restore manager.  
  - The `bpdbm` database manager.  
  - The `bpdm` disk manager.  
  - The `bptm` tape manager for I/O operations.  
  The log files reside in the following directories:  
  - UNIX: `/usr/openv/netbackup/logs/`  
  - Windows: `install_path\NetBackup\logs\` |
| Backups and restores                          | 117 | The `nbjm` Job Manager.                                                                                                                                 |
| Image cleanup, verification, import, and duplication | N/A | The `bpdbm` database manager log files.  
  The log files reside in the following directories:  
  - UNIX: `/usr/openv/netbackup/logs/bpdbm`  
  - Windows: `install_path\NetBackup\logs\bpdbm` |
| Credentials configuration                    | N/A | The `tpconfig` utility. The `tpconfig` command writes log files to the `tpcommand` directory.                                                        |
| Device configuration                          | 111 | The `nbemm` process.                                                                                                                                 |
| Device configuration                          | 178 | The Disk Service Manager process that runs in the Enterprise Media Manager (EMM) process.                                                    |
| Device configuration                          | 202 | The Storage Server Interface process that runs in the Remote Manager and Monitor Service. RMMS runs on media servers.                      |
| Device configuration                          | 230 | The Remote Disk Service Manager interface (RDSM) that runs in the Remote Manager and Monitor Service. RMMS runs on media servers.          |

See “Viewing OpenStorage disk reports” on page 112.

## Troubleshooting OpenStorage credentials creation

The NetBackup `tpconfig` command creates the credentials for the storage server.
To troubleshoot credentials problems

- Examine the log files for the \texttt{tpconfig} command
  
  See “NetBackup OpenStorage log files” on page 120.

  See “Creating NetBackup log file directories for OpenStorage” on page 120.
A
Active secondary operations 87
Auto Image Replication
  about 69
  Backup operation in source domain 70
  no disk spanning support 16, 70
  overview 69
  synchronizing clocks of master servers 70
  topology of storage 75

B
Backup
  operation 86
bpstsinfo command 76

C
configuring OpenStorage optimized synthetic backups 59
Coordinated Universal Time (UTC) 70
credentials
  OpenStorage 13

D
data classifications
  in storage lifecycle policies 80, 86
disk appliance
  plug-in 14
disk pools
  changing the state 100
  updating to reflect plug-in partner updates 93, 110
domains
  replicating backups to another. See Auto Image Replication
duplicating images to another NetBackup domain
  about 63
Duplication
  optimized 87
Duplication to remote master. See Auto Image Replication

I
Import
  operation 81
installing
  the OpenStorage vendor plug-in 25

J
job ID search in unified logs 118

L
legacy logging 119
directories 119
locations 119
logging
  legacy 119

M
Media Server Deduplication Pool
  changing the state 100
Media server storage unit setting 56
mklogdir.bat 119

N
nbstserv process 82
NDMP
  storage units 87

O
OpenStorage
  installing the vendor plug-in 25
  optimized duplication 87
  plug-in 14
  storage server, updating 93
OpenStorage Disk Option 79
OpenStorage disk pool
  updating 110
OpenStorage optimized synthetic backups
  about 17
  configuring 59
OpenStorage volume spanning
about 16
optimized duplication
  OpenStorage 16
optimized synthetic backups
  configuring OpenStorage 59
  OpenStorage 17

P
plug-in
  for a disk appliance 14
plug-ins
  updates 93, 110
policies
  changing properties 88
  creating 87
Postponed secondary operations 87
Priority for secondary operations 86

R
replication
  about duplicating images to another NetBackup domain 63
  between NetBackup domains. See Auto Image Replication
to an alternate NetBackup domain. See Auto Image Replication
Replication Director
  Policy Configuration Wizard, unsupported 88

S
server
  NetBackupdebug logs 119
SLP Parameters 67
snapshots
  operation type 86
spanning volumes
  OpenStorage 16
Status Collection Daemon 120
Storage Lifecycle Manager service (nbstserv) 82
storage lifecycle policies (continued)
  Storage lifecycle policy name 86
  utility 79
  Validate Across Backup Policies button 87
storage server
  about OpenStorage 12
storage servers
  updating to reflect plug-in partner updates 93, 110
storage unit groups
  and storage lifecycle policies 87
  not supported for Auto Image Replication
  source 70
storage unit properties
  OpenStorage 55
storage unit recommendations
  OpenStorage 57
synthetic backups
  no Auto Image Replication support 70

T
topology of storage 75–76

U
unified logging 115
  format of files 116
  location 115
updating an OpenStorage disk pool 110
updating an OpenStorage storage server 93
UTC (Coordinated Universal Time) 70

V
Validate Across Backup Policies button in SLP 87
Validation Report tab 87
vmscd 120
vmscd directory 120
volume spanning
  OpenStorage 16
vxlogview command 116
  with job ID option 118

W
wizards
  Policy Configuration 87